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Bevezetés a PR Master 4.2 használatába 

A PR Master 4.2 a Roger vállalat által forgalmazott CPR-32 típusú vezérlő 
központjain és PR típusú vezérlő egységein alapuló beléptető rendszer  
felügyeleti szoftvere. 

Az alkalmazás a következő operációs rendszerekkel kompatibilis: Microsoft 
Windows 98, Windows NT, Windows 2000 és Windows XP. 
 

• A szoftver Windows 95 operációs rendszer alatt is használható, azonban 
ebben az esetben a rendszer frissítése szükséges. A frissítési folyamat 
részletes leírása a www.roger.pl weboldalon található. 

• A RACS szoftver Microsoft Windows 98 és 2000 operációs rendszer alatt 
működik a legstabilabban. 

A PR Master 4.2 fő jellemzői: 

• beléptető rendszer adatbázissal dolgozik 

• konfigurálhatóak az adatbázis háttér fájljai 



• a konfiguráció exportálható és importálható egy külső XML fájlból és  
fájlba 

• automatikus vagy interaktív a rendszer események olvasása 

• az eseménynapló megtekinthető és abból jelentés készíthető 

• az események szöveg fájlba és munkaidő nyilvántartó szoftverbe 
exportálhatóak 

• felhasználói munkaidő nyilvántartás a meghatározott rendszer területeken 

• interaktív utasítások a vezérlőknek 

• valós időjű esemény kijelzés 

• esemény megfigyelés a helyi és távoli számítógépeken 

• esemény jelentések küldése e-mail címekre 

• online eseményjelentés szöveg fájlokba 

• a kezelő által szűrhető események 

• a rendszer grafikus megjelenítése 



Rövidítések 

A következőkben a legfontosabb fogalmak és definíciók magyarázata látható. A 
kezelési leírásban használt legtöbb szónak és kifejezésnek több értelmezése is  
lehetséges. Ezeket a szavakat, és kifejezéseket a beléptető rendszerrel 
összefüggésben használjuk. A következő szószedet ebben a kezelési leírásban 
használt kifejezéseket definiálja. 

A RACS rendszerrel kapcsolatos legfontosabb fogalmak: 

• RACS – A Roger beléptető rendszer (Roger Access Control System) egy 
beléptető rendszer hálózat, amely a PRxx1, PRxx2 sorozatú vezérlőkön, a 
PRT azonosító terminálokon (olvasók) és az opcionális CPR vezérlő 
központon alapul. 

• AC –Beléptető vezérlő (Access Control) 

• T&A – Munkaidő nyilvántartás (Time and Attendance) 

• Control panel (CPR) - Vezérlő központ - a RACS rendszer része, saját 
esemény memóriája van, összehangolja az összes vezérlő belső óráját, és  
a PRxx1 sorozatú vezérlőkön a belépési jogokat is kezeli. A vezérlő 
központ jelenléte a RACS rendszerben opcionális 

• Controller – Vezérlő – olyan eszköz, amely ellenőrzi a felhasználók 
mozgását egy zónán való áthaladáskor (egyirányú vagy kétirányú is  
lehet). Kétirányú áthaladás esetén kettő belépési pont szükséges. 

• Terminal – olyan távoli eszköz (olvasó), melynek fő célja az azonosító 
beolvasása és az adat elküldése a vezérlőbe, ahol majd az adat 
feldolgozása megtörténik. Az azonosító lehet pl.: proximity kártya, PIN 
kód, ujjlenyomat. 

• Proximity transponder – Proximity azonosító– olyan egyedi kódda l 
rendelkező elektronikus chip, melynek olvasása érintkezés nélkü l 
történik. Proximity azonosító lehet: ISO kártya vagy PVC kártya. 

• Access Point - Belépési pont – olyan átjáró (bejárat/kijárat), ahol a 
belépést egy vezérlő ellenőrzi. 

• User - Felhasználó – a beléptető rendszer adatbázisában regisztrált 
személy 

• System operator - Rendszer kezelő – a RACS rendszert működtető és  
ellenőrző személy. 



• Event history - Esemény napló – a rendszer működése alatt regisztrált 
események összessége. 

• Events buffer - Esemény memória – az események tárolására szolgáló,  
elemmel ellátott elektronikus memória. 

• Monitoring mode - Felügyeleti üzemmód – a PR Master-nek egy 
működési üzemmódja, amely események valós idejű megjelenítésére 
szolgál. Amikor a PR Master felügyeleti üzemmódban lép, az időközben 
előforduló események azonnal bekerülnek a rendszer adatbázisába, azok 
exportálhatóak lesznek, és azokból jelentés készíthető. 

 



Felhasználói útmutató 

A dokumentum könnyebb megértése, valamint a PR Master egyszerűbb 
használata érdekében, különböző típusú jegyzeteket és szimbólumokat 
alkalmaztunk. Az útmutató különböző elemei különböző célt szolgálnak. 

 

Telepítés, első indítás és regisztráció 

A szoftver a ROGER CD-ROM-on található, valamint letölthető a www.roger.pl 
weboldalról. A szoftver telepítéséhez indítsa el CD-n lévő start.exe futtatható 
programot. 

A PR Master csomag a következő programokból áll: 

- PR Master / - Nyelv választó / - Távoli felügyelet 

Először a program angol nyelvű verziója telepíthető. A nyelv 
megváltoztatásához hajtsa végre a következő lépéseket: 

• Válassza ki a menüből Start ->Programok -> Roger ACS 4.3 -> Select 
language 

• Válassza ki a nyelvet a menüből és kattintson az OK gombra 
 

 

A PR Master első indítása 

Ha a RACS szoftvert Windows XP Service Pack 2 alá telepíti, akkor a Windows 
tűzfalat konfigurálni kell. Amikor az első alkalommal futtatja a PR Mastert, a 
következő ablak jelenik meg: 

 



 

A PR Master indulásakor a program portokat próbál megnyitni, hogy a Távoli 
Felügyeleti alkalmazásokkal kommunikálni tudjon. Ha a RACS Távoli 
Felügyelettel fog dolgozni, akkor kattinson az Unblock  gombra, ha nem, akkor 
kattintson a Keep Blocking gombra. 

Operator login - Kezelő bejelentkezése 
 

 

Az alapértelmezett ADMIN kezelőhöz nincsen jelszó definiálva, a 
bejelentkezéshez kattintson az OK gombra. 

 



Database Verify and Repair - Adatbázis ellenőrzés és javítás 

Minden indítás előtt a PR Master ellenőrzi és kijavítja a RACS adatbázisát. A 
program automatikusan újra létrehozza a táblákat, ha hibát talál az adatbázisban.  
Az adatbázis indexek javítását menüből is végre lehet hajtani: Start -
>Programok ->Roger ACS 4.2 -> Repair database indexes. Ne felejtse el 
bezárni a PR Master szoftvert, mielőtt az adatbázis indexek javítását elkezdi. 

DEMO 

Amikor a PR Mastert első alkalommal indítja el, akkor lehetősége van DEMO 
konfiguráció betöltésére, mely lehetővé teszi a PR Master 4.2 sajátosságainak 
megismerését. 
A DEMO konfigurációban egy Hálózattal rendelkezik, több különböző típusú 
vezérlővel, és eseménytárolóval. A Demo.zip fájl a program mappájában 
található, a megnyitásához kattintson a fő menüre: Fájl -> Import 

REGISTRATION - REGISZTRÁCÓ 

A program regisztrálásához másolja a „PRlicence.ini”  licenc fájlt a ..\Program 
Files\Roger\Access Control System 4.2 könyvtárba. 

Licenc megrendeléséhez töltse ki a licenc megrendelő űr lapot, és küldje el azt a 
Masco Kft.-nek. A licenc megrendelő űrlap a program főkönyvtárában található,  
valamint a www.roger.pl weboldalról letölthető, az űrlap fájl neve „order.txt”. 

Megjegyzés: A szoftver minden funkciója működik, akkor is, ha az nincsen 
regisztrálva, azonban a licenc fájl nélkül a program maximum nyolc vezérlővel 
működhet. 

 

Autologin - Automatikus bejelentkezés 

Az „autologin” funkció automatikus bejelentkezést biztosít a PR Master 
szoftverbe. A funkció használatához néhány változtatásra van szükség a 
Konfig.ini fájlban, mely a PR Master főkönyvtárában található. 

• Nyissa meg a Config.ini fájlt (pl. : notepad használatával) 

• Keresse meg a következő részt: 

[Autologin] 

LOGIN=ADMIN 

PASSWORD= 



• A „LOGIN=” után adja meg a felhasználónevét, „PASSWORD=” után 
pedig a megadott felhasználónévhez tartozó jelszavát. 

Mialatt a PR Master elindul, az „autologin” szekciót a rendszer ellenőrzi. A 
program megpróbál bejelentkezni a megjelölt felhasználónévvel és jelszóval.  
Amennyiben a bejelentkezés sikertelen a következő ablak jelenik meg: 

 

 

Ha újra az alapértelmezett bejelentkezést szeretné használni, akkor a 
felhasználónevet és jelszót távolítsa el a Konfig.ini fájlból. 

Run MONITORING mode automatically - A FELÜGYELETI üzemmód 
automatikus futtatása 

Ahhoz, hogy a PR Master automatikusan felügyeleti üzemmódban indulhasson, 
az automatikus bejelentkezéshez az [Autologin] szekcióban a felhasználónevet 
és a jelszót adja meg, majd kövesse a következő utasításokat: 

• hozzon létre a PR Master alkalmazáshoz egy parancsikont 

• az egér jobb gombjával kattintson a korábban létrehozott parancsikonra és 
válassza a Properties / Tulajdonságok menüpontot 

• válassza a Shortcut / Parancsikon fület 

• a Target file / Cél mezőbe a meglévő elérési út után írja be: 

[SZÓKÖZ]: /AUTOLOGIN /MONITOR 

• kattintson az Apply/ Alkalmaz majd az OK/OK gombokra. 

 

MS Windows Server 2003-ra való telepítés 

Amikor a PR Mastert MS Windows Server 2003 alá telepíti, akkor a RACS 
adatbázisnak meg kell adni az elérési útvonalat. A művelet végrehajtásához 
kövesse a következő lépéseket: 

• indítsa el a Vezérlőpulton lévő BDE Administratort. 



• kattintson az Object/New gombra. 

• válassza ki a STANDARD opciót a Database Driver Name-ben. 

• gépelje be a „name” helyére, hogy „RACS_4_2_0”, abban az esetben, ha 
RACS4.2.X.X verziót használ. 

• gépelje be a RACS adatbázis elérési útvonalát (a „DATA” könyvtár a 
program főkönyvtárában található) 

• kattintson a főablakban található kék nyílra a változtatások elfogadásához. 

• zárja be a BDE Administrator-t. 

Megjegyzés: 

Speciális esetekben az útvonal módosítása nem lehetséges. Ha a RACS ikon 
zöld, akkor a hozzáférés nem lehetséges. Ebben az esetben kattintson jobb egér 
gombbal a RACS ikonra és válassza a Close / Bezárás -t a menüből. 

 

Rendszer követelmények és telepítési javaslatok 

Rendszer követelmények: 

• Operációs Rendszer: Windows XP, Windows 2000 (javasolt), vagy 
Windows NT, 98, 95 

• Processzor: minimum Pentium II, 500MHz 

• 512 MB RAM (1024 MB javasolt) a hálózati működéshez, 256 MB RAM 
csak a RACS konfiguráláshoz 

• 100 MB szabad lemezterület (minimum 250 MB javasolt) 

 

Telepítési javaslatok 

1. PR Mastert adminisztrátori joggal rendelkező felhasználóval telepítse. 

2. A RACS szoftver alapértelmezettként a Program Files könyvtárba 
települ. Ha másik könyvtárba akarja telepíteni, akkor kattintson a Change 
gombra és adja meg az új elérési utat. A folytatáshoz nyomja meg a Next 
gombot. 

 



 

3. A program induláskor megpróbálja a TCP portokat megnyitni a Remote 
Monitor / Távoli felügyelet alkalmazás számára. Abban az esetben, ha a 
TCP port, amely alapértelmezés szerint a 64181 foglalt, a Távoli 
felügyelet nem lesz képes csatlakozni a PR Masterhez. Ebben az esetben a 
következő figyelmeztetés jelenik meg: 

 

A probléma megoldásához nyissa meg a Konfig.ini fájlt, amely a PR Master  
főkönyvtárában található, és változtassa meg az alapértelmezett portot, azaz  
a PORT= 64181 –et egy másik PORT-ra írja át. Könnyen ellenőr izheti, hogy 
mely portok foglaltak a rendszerben, ha a parancssorba a netstat –a parancsot 
begépeli. 

4. Ha az operációs rendszerben a felbontás meghaladja a 96 DPI-t, akkor 
problémák lehetnek az ablakok megjelenítésével. A javasolt felbontás a 
normál méret (96 dpi). 

 



A RACS adatbázis rendszere 

A PR beléptető rendszerek összes beállítását és eseményét, ami az ON-LINE 
művelet során elmentésre került, azt a PR Master megőrzi a rendszer  
adatbázisában. Az események hozzáfűződnek a rendszer adatbázisához, minden 
esetben, amikor a Read events buffer(s) / Esemény napló olvasó vagy 
Monitoring function / Felügyeleti funkció lefut. A rendszer konfigurációt és  
az eseményeket vagy mindkettőt külső, *.xml vagy *.zip kiter jesztésű fájlba 
lehet exportálni, illetve ugyanezen fájlokat be is lehet importálni. A PR Master  
lehetővé teszi a felhasználók számára az automatikus mentések (backup 
configuration / mentés konfigurálása) készítését a kiválasztott adatokból 
(események, konfiguráció). Az adatbázis könnyen visszaállítható egy esetleges  
adatbázis sérülés után az automatikus mentések segítségével. 

PR Master külső fájlok: 

• Konfig fájl *.xml kiter jesztéssel 

• Események fájl *.xml kiter jesztéssel 

• Backup file *.zip kiterjesztéssel (konfiguráció + események) 

Új rendszer konfigurációs fájl létrehozásához, válassza a menüből a File->New 
menüpontot. 

 

A PR Master lehetővé teszi a felhasználók számára a következőket: 

• Helyi rendszer adatbázis – helyileg a számítógépen 

• Hálózati rendszer adatbázis – megosztva a helyi hálózaton 

A helyi rendszer adatbázis megtalálható a PR Master főkönyvtárában. A hálózati 
rendszer adatbázis megosztott a helyi hálózathoz kapcsolt számítógépek között. 

Helyi rendszer adatbázis 

Helyi rendszer adatbázist az egyszerű, egy PC-re való telepítésekkor használnak.  
Ez a legjobb megoldás, amikor elég egy számítógépről megoldani a 
rendszervezérlést és konfigurálást. 



Hálózati rendszer adatbázis 

Hálózati adatbázis csak abban az esetben használható, ha a beléptető rendszer  
egy UT-4 kommunikációs illesztővel van összekapcsolva. A hálózati 
adatbázisnak köszönhetően lehetőség van több PC-ről is a PR Master  
segítségével a rendszer konfigurálására, és vezérlésére. 
Ez a lehetőség nagyon hasznos, különösen abban az esetben, ha különböző PC-
ken több felhasználó akarja használni a RACS rendszert. Ne felejtsük el 
azonban, hogy a PR Master nem tipikus hálózati alkalmazás. Egy időben csak 
egy PR Master alkalmazás tudja az adatbázis elemeit használni, ezért 
amennyiben más ik PC-n is megpróbáljuk futtatni a programot a következő ablak 
jelenik meg, majd az alkalmazás bezár. 

 

Kövesse a következő lépéseket, hogy a RACS rendszert úgy konfigurálhassa, 
hogy az hálózati adatbázissal működhessen. 

• Másolja a  Data könyvtárat, amely az x:\Program Files\Roger\Access 
Control System 4.2-ben található, ahol x a saját operációs rendszerének 
meghajtója 

• Illessze be a Data könyvtárat a hálózatban arra a helyre, ami a többi 
számítógéppel is meg van osztva 

• Ossza meg a Data könyvtárat a helyi hálózatban (Sharing and Sercurity / 
Megosztás és Biztonság) 

• Engedélyezze Change / Módosítás és a Read / Olvasás opciókat a 
kiválasztott hálózati felhasználóknak 

• Nyissa meg a Data/NET könyvtárat és törölje a következő fáljlokat : 
PDOXUSRS.NET, PARADOX.LCK, PDOXUSRS.LCK 

• Futtassa a Vezérlő pultból a BDE Administrator-t, a következő ablak 
jelenik meg: 

 



 

 
• Válassza ki a RACS_4_x_x – et (az Ön RACS verziójától függően) a ba l 
oldali listából. Adja meg a Data könyvtár elérési útját a PATH mezőbe, és  
az adatok elfogadásához kattintson a kék nyílra a menüsorban. 
• Zárja be a BDE Administrator-t. 
Megjegyzés: 

Minden PR Masterrel dolgozó gépen hajtsa végre ezt a konfigurációt. 
 
Amennyiben probléma merül fel a BDE Administratorral kövesse a következő 
lépéseket: 
 

• Futassa a Vezérlő központból a BDE Administratort 
• Válassza ki az INIT ikont 
• Ellenőrizze, hogy a LOCAL SHARE / Helyi megosztás bejegyzése 

FALSE / HAMIS állapotban van, ha nem, akkor állítsa HAMIS-ra. 
 



 
 
 

A program használata 

Fő ablak 

A PR Master fő ablakának elemei: fő menü, operátor eszköztár (a bal oldalon),  
belépési pontok listája, licenc és kezelő információk. Az operátor eszköztár a 
legjobb üzemmódja a fő rendszer funkciók elérésének. 

 
Megjegyzés: 

Általában egy „segítség” jelenik meg, ha a kurzor egy ikonhoz, mezőhöz vagy 
gombokhoz közelít. 
 



 
 



Főmenü 

A Főmenü a program eszközeit és opcióit tartalmazza. 

 

 

Szerkesztés 

Installer / Telepítő 

Egy olyan felhasználó van a PR rendszerben, akinek nincs ID száma és nincs 
jogosultsága az ajtók nyitására és egyéb rendszereszközök használatára. Ő az 
INSTALLER / TELEPÍTŐ. A telepítő kizárólag manuális úton képes belépni a 
vezérlő telepítő program üzemmódjába. 

Nem kötelező a TELEPÍTŐ felhasználó felprogramozása a PR Masterben. 



Megjegyzés: 

A RACS vezérlők programozását csak a PR Masterből végezze. A vezérlő 
memória tartalmának bármilyen telepítői  vagy felhasználói üzemmódban 
történő megváltoztatása összeférhetetlenséget eredményezhet a rendszer  
adatbázisával. 

 

 

Arm / Disarm schedule - Élesített/Hatástalanított ütemező 

A beléptető rendszernek két működési üzemmódja létezik: Élesített és 
hatástalanított üzemmód. Az aktuális vezérlő működési üzemmódja, a kétszínű 
LED állapotán látható, amelynek fénye piros, ha Élesített avagy zöld, ha 
Hatástalanított üzemmódban működik. Jellemzően az Élesített és Hatástalanított 
üzemmódok arra lettek kitalálva, hogy a vezérlőket összekapcsolja azon r iasztó 
rendszerekkel, amelyek megvédik ugyanazokat a szobákat vagy helységeket,  
amelyeket a beléptető rendszer ellenőriz. Használható azonban bármely más  
olyan ellenőrző célból is, amely egy Be illetve Kikapcsolt állapot ellenőrzését 
teszi szükségessé. A riasztó rendszerrel (esetleg más eszközzel, vagy 
rendszerrel) való integrációhoz szükség van egy kimenetre, amit a 0. számú 
(Disarm mode / Hatástalanított üzemmód) funkcióhoz kell konfigurálni, és egy 
bemenetre, amit a 13. számú (Ready status / Kész állapot) funkcióhoz kell 
konfigurálni. A vezérlő kimeneti vonala (0.számú funkció) mutatja a vezérlő 
jelenlegi működés i üzemmódját, a bemeneti vonal (13.számú funkció) ellenőrzi,  
hogy a vezérelt rendszer (vagy eszköz) kész e arra, hogy élesítsék (vagy be van 
kapcsolva). 



Megjegyzés: Abban az esetben, ha a telepítő nem határoz meg egyetlen 
vezérlőnél sem bemenetet a 13.-as funkcióhoz, akkor a vezérlő feltételezi, hogy 
a riasztó rendszer mindig kész az élesítésre és állapottól függetlenül élesíti azt. 

Megjegyzés: A tápellátás kiadásakor az olvasó automatikusan visszaáll abba 
az Élesített/Hatástalanított állapotba, amelyben az a tápellátás elvétele előtt volt.  
A programozói üzemmódból való kilépés után az olvasó visszatér az eredeti 
Élesített vagy Hatástalanított állapotába. Memóriatörlés után az olvasó mindig 
Élesített üzemmódba kapcsol. 

Élesített/Hatástalanított üzemmód közötti váltás a következőképpen valósulhat 
meg: 

• Automatikusan, a beállított Élesített/Hatástalanított ütemezőtől függően 
• Helyileg MASTER, KAPCSOLÓ vagy KORLÁTOZOTT KAPCSOLÓ 

azonosítókkal 
• Helyileg bemeneti vonallal vagy az [F1-F2] gombokkal melyek, a 

következők szerint lehetnek konfigurálva: 
 

1. [No.3: Élesített/Hatástalanított Állandó Kapcsoló] 
2. [No.61: Élesített/Hatástalanított Pillanatnyi Kapcsoló] 
3. [No.78: Hatástalanított üzemmód beállítása] 
4. [No.79: Élesített üzemmód beállítása] 
 

• Helyileg billentyűparancson keresztül: 
 

1. [No.11: Hatástalanított üzemmód beállítása] 
2. [No.12: Élesített üzemmód beállítása] 
3. [No.13: Hatástalanított/Élesített üzemmód közötti választás] 

 

• Távoli interaktív paranccsal PC-ről (Parancs a vezérlőnek) 
 

Megjegyzés: Abban az esetben, ha az Élesített/Hatástalanított üzemmód 
vezérlése a bemeneti vonalon a [3, 78, 79. számú] funkcióval vagy 
billentyűparanccsal van megoldva, akkor az összes többi üzemmód 
automatikusan érvényét veszíti. 

A vezérlő Élesített/Hatástalanított üzemmódja automatikusan is átkapcsolható az 
előre definiált ütemezővel. Ezt engedélyezheti a Contoller properties/ Vezérlői  
tulajdonságok Options /Opciók fülnél az Enable Arm/Disarm Schedule / 
Élesített/ Hatástalanított ütemező engedélyezése opcióval. 



Az automatikus riasztást késleltetni is lehet, a Default Auto-arming Delay when 
alarm system not ready/ Alapértelmezett automatikus riasztás késleltetése,  
amikor a riasztó rendszer nem kész opción keresztül és manuális indítás is  
lehetséges az Elhalasztott automatikus riasztás késleltetés segítségével. 

Lásd még: 

Controller properties – options / Vezérlői tulajdonságok – opciók 

 

 

Holidays / Ünnepnapok  

Ünnepnapok - olyan speciális napok, amelyek egy éves időtartamra 
meghatározhatóak. Ez lehetővé teszi, időpontok hozzárendelését a következők 
szerint: 

• kiválasztva a hét egy napját (Hétfő….Vasárnap) 

• H1-től H4-ig meghatározza az időzítést az év bizonyos napjaira 

Időzítő beállítása H1-től H4-ig: 

• Nyissa meg az Schedules-> General purpose schedules / Ütemezők-
>Általános célú ütemezők menüpontot 



• Kattintson a H fülre 

• Az új időzítőhöz kattintson a Add / Hozzáadás gombra 

példa: Határozzuk meg a „Húsvét” ünnepét, mely április 12-én lesz, a rendszer  
a H1 időzítőt fogja használni ennek a napnak a beállítására. 

 

Az ünnepnap meghatározása: 

• kattintson az ADD/ Hozzáadás gombra, és a következő ablak jelenik meg: 

 

• adja meg az ünnepnap Nevét / Name 

• válassza ki a Napot / Day és a Hónapot/ Month a menüből 

• válassza ki a Típusát / Type - időzítő (hét napjai vagy H1-H4) 

Megjegyzés: 

Régi típusú vezérlőkön (PRxx1) az ünnepnap kezelése nem lehetséges. 



Attendance / Jelenlét 

Jelenléti területeket kell létrehozni a T&A (munkaidő nyilvántartás) jelentések 
készítéséhez. A T&A jelentésben szereplő felhasználó belépésének / Entry és 
kilépésének /Exit ideje, olyan nélkülözhetetlen elem, amivel az összes idő / 
Total Time kiszámolásra kerül. Speciális esetekben a User Attendance report/ 
Felhasználói Jelenléti jelentés számolja ki a felhasználó (alkalmazott) effektív 
jelenlétét, pl. : termelési területen vagy irodai területen. A különbség a T&A 
jelentés és a Felhasználói jelenléti jelentés között, hogy az utóbbi a T&A 
üzemmódokat nem tartalmazza. 

 



Új Jelenléti terület hozzáadása: 

• kattintson az Add / Hozzáadás gombra és adja meg a terület nevét 

• kattintson az OK gombra a megerősítéshez 

• kattintson az Add / Hozzáadás gombra hogy meghatározza a belépés i 
pontokat, ahol a belépési események regisztrálva lesznek: 

 

• válassza ki a belépés i pontokat a listából majd kattintson az Add selected / 
Kiválasztott hozzáadása gombra 

• kattintson az Add / Hozzáadás gombra a kilépési pontok 
meghatározásához, ahol a kilépési események regisztrálva lesznek 

• válassza ki a kilépési pontokat a listából majd kattintson az Add selected / 
Kiválasztott hozzáadása gombra 

• kattintson a Close / Bezárásra 

 

Card Box/ Kártya doboz 

A Kártya doboz egy olyan eszköz, amely lehetővé teszi a RACS azonosítók 
kezelését. A funkció a fő előnye, hogy az azonosítók egymás után lesznek a 
rendszerbe regisztrálva. Ez a legjobb megoldás, ha sok új azonosító kártyát kell 
létrehozni. 



Új azonosítók hozzáadása a Kártya dobozhoz: 

• kattintson az Edit -> Card box / Szerkesztés ->Kártya doboz 
menüpontra 

 

• kattintson az Add Card / Kártya hozzáadása gombra, és a következő 
ablak jelenik meg: 

 

 



• válassza ki, hogy melyik vezérlőn/olvasón kívánja a kártya kódját 
beolvasni 

• kattintson az Read / Olvasás gombra 

• Közelítse az azonosítókat a leolvasóhoz egyesével, rövid szünetet 
tartva egy-egy leolvasás között 

• a Cancel / Mégsem  gombra kattintva az azonosítók bevitele 
befejeződik 

Abban az esetben, ha az azonosítót korábban már hozzáadta a Kártya dobozhoz,  
a következő hibaüzenet jelenik meg: 

 

Miután az új azonosítók regisztrálása megtörtént, a felhasználó kap egy listát a 
szabad azonosítókról. 

A PR Master megmutathatja: 

• a szabad azonosítókat – amelyek nincsenek felhasználókhoz rendelve 

• a foglalt azonosítókat – amelyek már hozzá lettek rendelve más  
felhasználókhoz, ezen kívül megmutatja a felhasználó nevét és  
azonosítóját 

Megjegyzés: 

A regisztrált kártyát nem lehet visszavonni, ha az már felhasználóhoz van 
rendelve. 

 

F7 Ujjlenyomat olvasók 

Ez az opció lehetővé teszi azoknak az Ujjlenyomat olvasóknak a kezelését és  
konfigurálását, amelyek a beléptető rendszerrel össze vannak kötve. Az F7 
olvasó összeköthető az UT-2 kommunikációs illesztővel, vagy közvetlenül a 
LAN hálózattal. Ha az ujjjlenyomat olvasó a helyi hálózattal van összekötve, 
akkor az F7 IP címét meg kell adni. 



 

Új F7 Ujjlenyomat olvasó hozzáadása: 

• válassza az Edit -> F7 Fingerprinter Readers / Szerkesztés-> F7 
Ujjlenyomat olvasók menüpontot 

• kattintson az Add/Hozzáadás gombra, és a következő ablak jelenik meg: 

 

 

• adja meg az olvasó Reader description or name / Olvasó leírása vagy 
neve 

• válasszon kommunikációs portot (COM vagy TCP/IP) 

• amennyiben TCP/IP lett kiválasztva, az olvasó IP címét, és portját is meg 
kell adni (alapértelmezett: 4370, a legtöbb esetben nem kell 
megváltoztatni) 



• amennyiben COM port lett kiválasztva, az olvasó ID / címét meg kell adni 

• adja meg a Comm password / Komm jelszót  (alapértelmezett: 123456 ) 

• kattintson az OK gombra 

 

Megjegyzés: 

A Kommunikác iós jelszó szükséges az F7 olvasó beállításaihoz. Ha meg akarja 
változtatni az olvasó alapértelmezett jelszavát, akkor azt az F7 konfigurációs  
ablakában teheti meg. 

 

A Diagnostic / Diagnosztikai opció leírása: 

• Firmware version / Firmware verzió – megmutatja az olvasó firmware 
verzióját 

• Device MAC  / Eszköz MAC – megmutatja az eszköz fizikai címét 

• Megadja egy olvasón belüli felhasználók számát 

 

• Megadja egy olvasón belül az ujjlenyomat minták számát 

• Lehetőséget biztosít a dátum és idő kiolvasására 

 

A parancsok leírása: 

• Set date and time / Dátum és idő beállítása – a jelenleg dátum és idő 
beállítása, szinkronizálás a PC órájával 

• Restart / Újraindítás – a kiválasztott olvasó újraindítása 

• Delete all users / Az összes felhasználó törlése – felhasználók eltávolítása 
a memóriából 



• Update firmware / Firmware frissítés – Firmware frissítése újabb 
verzióra 

APB Zones / APB Zónák  

 

Az APB Zónák meghatározása: 

• Új APB zóna meghatározásához, kattintson az Add/Hozzáadás  
gombra, és a következő ablak jelenik meg: 

 



• adja meg az APB zóna Name / Nevét 

• válasszon Network/ Hálózatot 

• a megerősítéshez kattintson az OK gombra 

• az összes zóna meghatározása után, meg kell adni az útvonalat.  
Kattintson az Add Passage / Átjáró hozzáadása menüpontra, és a 
következő ablak jelenik meg: 

 

• válasszon a listából a lehetséges vezérlők közül 

• válassza a Entry to APB zone / Belépés az APB zónába  (zóna,  
amelybe az átjáró vezet) 

• kattintson az Add/Hozzáadás gombra 

 

Megjegyzés: 

Az APB zónák használatához CPR vezérlő központ szükséges. 

 

ARM Zones / Élesített Zónák 

Az ARM zóna egy meghatározott vezérlők csoportja, ahol az összes eszköz 
egyszerre kapcsolható ÉLESÍTETT vagy HATÁSTALANÍTOTT üzemmódba. 
Ez azt jelenti, hogy a vezérlő ÉLESÍTETT üzemmódba kapcsolása, az összes 
vezérlőnél, amely ugyanabba az ARM zónába tartozik, élesítést eredményez, és  
a vezérlő HATÁSTALANÍTOTT üzemmódba kapcsolása, az összes vezérlőnél,  
amely ugyanabba az ARM zónába tartozik, hatástalanítást eredményez. Az 
ARM Zones hierarchy / ARM Zóna hierarchia lehetővé teszi a zónák 
elrendezését a megfelelő sorrendbe. Például, néhány ARM zóna alacsonyabb 
besorolása esetén a zónák a felsőbb zónával egyszerre lesznek élesítve. 
Magasabb besorolású ARM zónák ÉLESÍTETT üzemmódba helyezése az 



összes alacsonyabb besorolású ARM alzóna élesítését is eredményezi. Az ARM 
zónák hatástalanítását minden zónában egyedileg kell végrehajtani. 

Megjegyzés: 

Ez a funkció CPR host vezérlőt igényel. 

 

Az ARM zónák meghatározása: 

• válassza az Edit -> ARM Zones / Szerkesztés -> ARM Zónák menüpontot 
a főmenüből 

• új ARM zóna meghatározásához kattintson, az Add / Hozzáadás gombra 



 

• adja meg az ARM zóna Name / Nevét 

• válasszon Network/ Hálózatot a menüből 

• kattintson az OK gombra a megerősítéshez 

• kattintson az Add / Hozzáadás gombra, a Vezérlők kiválasztott ARM 
zónához rendeléséhez 

Az összes szükséges ARM zóna meghatározása után, a zónák hierarchiáját meg 
lehet változtatni. Az összes új ARM zóna sárga kulcsos ikonként jelenik meg,  
(lásd a képen). Ha a zónák egy vonalban jelennek meg, az azt jelenti, hogy 
egyenrangúak. A hierachiai sorrend megváltoztatásához, pl.: az egyik ARM 
zóna egy másik zóna alzónájaként jelenjen meg, kattintson a kulcs ikonra és a 
drag&drop módszerrel húzza a kívánt helyre, majd engedje el az egér gombját. 

 

Commands / Parancsok 

Ebből a menüből a parancsok az egész RACS rendszerre vonatkoznak (az összes 
hálózatra). 

• Read event buffer(s) / Esemény memória olvasása – események 
olvasása az összes hálózatról 

• Clear event buffer(s) / Esemény memória törlése– események törlése 
az összes hálózatban 

• Update system / Rendszerfrissítés - konfigurációs beállítások elküldése 
az összes eszközhöz a rendszerben 

• Update system later / Későbbi rendszerfrissítés – egy meghatározott 
időben a konfigurációs beállítások elküldése az összes eszközhöz a 
rendszerben  



• Update clock(s) / Órák frissítése – a rendszerben lévő belső órákat a PC 
órájához igazítja 

Megjegyzés: 

A Későbbi rendszerfrissítés opció nagy rendszerek esetén hasznos, ahol a 
konfigurációk elküldése a felhasználók mozgásával egy időben problémát 
okozhat. 

 

 

Tools / Eszközök 

Quick user update / Gyors felhasználói frissítés 

A gyors felhasználói frissítés lehetővé teszi a felhasználói beállítások 
szerkesztését, és a változtatások azonnali elküldését az összes rendszernek. A 
standard konfigurációküldéshez képest az a különbség, hogy ez a funkció csak 
egy felhasználó beállításait küldi el, ezért ez az adatátvitel sokkal gyorsabb. 

 



T&A modes / T&A Munkaidő nyilvántartási üzemmódok 

Az T&A üzemmód egy elem, amely a T&A jeleket (Belépés, Kilépés, Hivatalos  
kilépés) hozzácsatolja az Access granted / Érvényes belépés eseményhez. A 
vezérlőn történő minden érvényes belépés eseményhez kerül egy T&A jel (T&A 
állapot), amely meghatározza, hogy milyen típusú belépés/kilépés történt. A 
T&A regisztráció aktuális típusát a vezérlő T&A üzemmódja határozza meg.  
Minden T&A üzemmódnak saját ID száma van 0-tól 255-ig, 0-tól 25-ig a 
számok olyan előre meghatározott T&A üzemmódok számára vannak 
fenntartva, melyek nem módosíthatók vagy változtathatók. 

Előre meghatározott T&A üzemmódok: 

• Entry / Belépés 

• Exit / Kilépés 

• On-duty exit / Hivatalos kilépés (ODE) 

• No T&A (Ignored for T&A) / Nem T&A 

Amikor a vezérlő Nem T&A  üzemmódban van, az azt jelenti, hogy az 
események amelyek ez alatt az üzemmód alatt történnek, nem játszanak szerepet 
a T&A jelentésben, és számításban. A customer defined / kezelő által létrehozott 
üzemmódok akkor lehetnek hasznosak, amikor egy új belépési/kilépési pontot 
kérnek a felhasználói jelenlét részletesebb regisztrációjára. 204 T&A üzemmód 
különböztethető meg (50-től 254-ig). A RACS rendszerben minden belépés i 
pontnak (vezérlő/olvasó) lehet saját alapértelmezett T&A üzemmódja. A 
létrehozott T&A üzemmódot alapértelmezetté teheti a Vezérlők tulajdonságainál 
(Controllers -> Properties -> Terminal ID0,ID1 / Vezérlők -> Tulajdonságok -> 
Olvasó ID0,ID1). Az olvasók T&A üzemmódját nem lehet dinamikusan 
változtatni, csak abban az esetben, ha az Olvasó ID=0, és az Olvasó ID=1 
ugyanarra a T&A üzemmódra van állítva. 

Új  T&A Munkaidő nyilvántartási üzemmód hozzáadása: 

• kattintson az Add/Hozzáadás gombra (állítson be minden paramétert) 

• adja meg a Code / Kódot és a Name / Nevet 

• adja meg az LCD message / LCD üzenetet (csak LCD-vel ellátott 
vezérlők esetén) 

• állítsa be a Direction / Irányt 

• állítsa be a P/D – t 



Lásd még: 

T&A jelentések 

T&A üzemmód átkapcsolása 

 

 

A T&A üzemmód átkapcsolása 

A vezérlő T&A üzemmódja  dinamikusan megváltoztatható a következő módon: 

• T&A üzemmód beállítása billentyűzetről 

• T&A üzemmód beállítása az F1-F4 funkció billentyűk segítségével 

• T&A üzemmód beállítása bemenetről 

• T&A üzemmód automatikus beállítása, a T&A üzemmód ütemezőtő l 
függően 

• T&A üzemmód beállítása a [*] [#] parancsok segítségével, melyek a 
vezérlő billentyűzetén találhatóak (PR302LCD) 

 

 

 



T&A üzemmód beállítása billentyűzetről 

A telepítő a vezérlő billentyűzetéről engedélyezheti, vagy letilthatja a T&A 
üzemmód dinamikus beállítását. A T&A üzemmód manuális változtatása 
beállítható korlátozott időtartamra (pillanatnyi változtatás), vagy korlátlan 
időtartamra (tartós változtatás). „Pillanatnyi változtatás” használatakor az 
újonnan kiválasztott T&A üzemmód a legközelebbi „belépés engedélyezve” 
eseményre lesz érvényes. „Tartós változtatás” használatakor az összes „belépés  
engedélyezve” esemény, amely a kiválasztott T&A üzemmód alatt előfordul,  
ugyanazt az (új) T&A jelet kapja. 

BEMENETEK: 

T&A üzemmód beállítása bemenetről 

A telepítő egy vagy több bemeneti vonalat a vezérlő kívánt T&A üzemmódjának 
beállítására használhat. A bemeneti vonal speciális T&A üzemmód 
beállításához, vagy a vezérlő különböző T&A üzemmódjai közötti 
átkapcsoláshoz is használható. Az a bemeneti vonal, amely dinamikusan 
változtatja a T&A üzemmódokat nagyon hasznos, különösen abban az esetben, 
amikor egy külső gombbal kell kiválasztani a T&A üzemmódot. 

Tartós T&A üzemmód beállító bemenet 

Ha a bemeneti vonal megkapja az indító jelet, a vezérlő a következő előre 
definiált T&A üzemmódra vált, és a következő parancsig, amely újra meg nem 
változtatja azt,  ebben a üzemmódban marad. 

Pillanatnyi T&A beállító bemenet 

Ha a bemeneti vonal megkapja az indító jelet, akkor a vezérlő a következő előre 
definiált T&A üzemmódra vált, és a következő Kártya / PIN bevitelig ebben a 
üzemmódban marad, ezután pedig a  vezérlő visszavált az előző T&A 
üzemmódra.  Abban az esetben, ha 8 másodpercen belül nincs Kártya/PIN 
bevitel, akkor a vezérlő automatikusan visszaáll az előző T&A üzemmódra. 

Előre definiált T&A üzemmód beállító bemenet 

Ha a bemeneti vonal megkapja az indító jelet, a vezérlő a dedikált T&A 
üzemmódra vált, és a következő parancsig, amely újra meg nem változtatja azt,   
ebben a üzemmódban marad Az összes bemeneti vonallal lehet egyedi T&A 
üzemmódot  beállítani. Például az IN1 bemenetet „Kilépés”-re, az IN2 
bemenetet „Belépésre”, és az IN3 bemenetet „Hivatalos kilépés” –re be lehet 
állítani. 

T&A üzemmód vezérlése időzítővel 



A T&A üzemmód időzítő segítségével a vezérlő T&A üzemmódját 
automatikusan, a meghatározott időzítő részleteitől függően meg lehet 
változtatni. A T&A üzemmód időzítő meghatározza, hogy milyen T&A 
üzemmód lesz beállítva a vezérlőn a nap, a hét vagy az ünnepnapok különböző 
időpontjaiban. 

A bemenetek típusai 

Ez a tulajdonság lehetővé teszi a felhasználók számára, hogy újabb speciális  
bemeneteket adjanak a listához. Az előre meghatározott (pirossal írt) bemenetek 
nem szerkeszthetőek. A felhasználó meghatározhat új bemeneti típust is, hogy 
megtudja a vezérlőhöz kötött egyéb eszközök állapotát. (például füstérzékelőét) 

Megjegyzés: 

Az újonnan definiált bemenet típusok alapértelmezett beállításai: 

• aktivált – ALARM event / RIASZTÁSI esemény 

• visszaállt – NORMAL event / NORMÁL esemény 

A vezérlő négy bemenetéből egyhez hozzárendelhető az új bemenet funkció. Az 
általános célú időzítőnek megfelelően vezérelhető az összes bemeneti vonal 
működése. 

 

 

Lásd még: 

Bemenetek 
Kimenetek 
Általános célú időzítők 



Esemény típusok  

Ez az ablak tartalmazza az összes olyan esemény listáját, amelyet a rendszer  
regisztrál. A felhasználó ennek a segítségével határozhatja meg a NORMAL / 
NORMÁL és az ALARM / RIASZTÁSI eseményeket. Az esemény típusának 
NORMALRÓL RIASZTÁSRA, vagy éppen fordítva való megváltoztatásához 
kattintson a Change type / Típus változtatás gombra. 

 

A vezérlő riasztási állapota: 

• Előriasztás – ha 1 percen belül egymás után háromszor ismeretlen 
azonosító fordul elő 

• Félig nyitott ajtó – ha egy ajtó hosszabb ideig marad nyitva, mint ami a 
„Time for door closing” /  „Ajtózárási idő”-ben meg lett határozva 

Vezérlői tulajdonságok – Belépés 

• Erőszakos belépés – ha többször egymás után erőszakos ajtónyitás fordul 
elő 

A beléptető vezérlőn 3 perc után automatikusan eltűnik minden riasztási jel. A 
riasztás érvényes azonosítóval, vagy interaktív paranccsal a 3 perc eltelte előtt is  
törölhető. 

A rendszer riasztás a PR Masterből a következő módon törölhető: 

• Networks -> Commands ->Clear all alarms in network / Hálózatok -> 
Parancsok -> Összes riasztás törlése a hálózatból 

• Networks->Controllers -> Clear alarm on controller/ Hálózatok -> 
Vezérlők -> Riasztás törlése a vezérlőből (csak a kiválasztott vezérlő) 



• Monitoring->Commands / Felügyelet -> Parancsok  (az összes vagy a 
kiválasztott riasztás törlése) 

Megjegyzés: 

1. Felügyeleti üzemmódban a r iasztási esemény az „Alarm” /”Riasztás” 
ablakban is megjelenik. („Alarm” / „Riasztás” sáv villog) 

2. Ha egy időben egy vezérlőn egynél több r iasztás fordul elő, akkor csak a 
magasabb prioritással rendelkező riasztást jelzi, de minden riasztást 
regisztrál, és a felügyeleti ablakban kijelez. 

Program kezelők 

Az ADMIN kezelők új program kezelőket hozhatnak létre, és engedélyezhetik,  
illetve letilthatják a PR Master egyes menüpontjainak elérését. Ez biztosítja,  
hogy az összes műveletet meghatározott kezelőhöz lehet majd kötni. Az összes 
felhasználói név jelszóval védhető (max. 16 karakter), amelyet akkor kér a 
rendszer, amikor a kezelő bejelentkezik, vagy egy alkalmazást zárolnak. A 
jelszót a Tools ->Change password / Eszközök ->Jelszóváltoztatás menüpont 
alatt lehet megváltoztatni. 

Új program kezelő meghatározása: 

• Válassza ki a főmenüből: Tools -> Program operators / Eszközök -> 
Program kezelők menüpontot 

• Kattintson az Add/Hozzáadás gombra 

• A menüpontokat engedélyezheti, illetve letilthatja a menüpontok mellett i 
ellenőrzőmező kijelölésével, illetve a kijelölés megszüntetésével 

• Kattintson a Monitoring / Felügyeletre 

• A Felügyeleti menüpontokat engedélyezheti, illetve letilthatja a 
menüpontok melletti ellenőrzőmező kijelölésével, illetve a kijelölés  
megszüntetésével 

• Kattintson az OK gombra 

• A változtatások mentéséhez kattintson az Apply / Elfogad gombra 

Megjegyzés: 

1. A jelszóban a kis és nagybetűket a rendszer megkülönbözteti, ezért 
figyeljen a Caps Lock billentyű állapotára. 



2. A jelszó nem jelenik meg és nem nyomtatható ki, a rendszer csillagokka l 
jelzi azt. 

 

 

Megjegyzés: 

Az alapértelmezett ADMIN kezelőnek nincs jelszava. 

Lásd még: 

Belépéséi jogok a felügyeleti ablakhoz 
Program zárolás 
Jelszó megváltoztatása 

 

Jelszó megváltoztatása 

Az aktuális kezelő jelszavának megváltoztatása. Először adja meg a régi jelszót, 
majd az Új jelszót és végül erősítse azt meg. 

Megjegyzés: 

Ügyeljen a Caps Lock billentyű állapotára,  ha az világít, lehet hogy hibásan 
adta meg jelszavát. 



 

 

Program zárolás 

A program zárolható, egészen addig, amíg a legutóbb bejelentkezett kezelő a 
jelszavát be nem gépeli. Ez védelmet nyújt egyéb kezelők nemkívánatos  
tevékenysége ellen. Zárolt program esetén a következő ablak jelenik meg: 

 

A zárolt program feloldására a felhasználónak a már belépett kezelő jelszavát 
meg kell adnia. 

 

Lásd még: 

Jelszó megváltoztatása 

 

Options / Opciók 

CSV jelentések 

Ha az Online Events Report file update/ Online Események Jelentései fájl 
frissítése opció engedélyezett, akkor az események Felügyeleti üzemmódban 
folyamatosan hozzáfűződnek a  CSV fájlhoz. Az esemény tár minden olvasási 
folyamata aktualizálja a CSV fájlt. A felhasználó kiválaszthatja a jelentés  
tartalmát az Events Report file format / Esemény Jelentési Formanyomtatvány 
menüpont alatt és meghatározhatja a CSV fájl maximális méretét. A napi 



jelentések létrehozása opció lehetővé teszi, hogy a napi események számára 
fájlok készüljenek. 

Lásd még: 

CSV Jelentések 

 

 

 

T&A Jelentések 

Amikor az Online T&A file update / Online T&A fájl frissítés opciót 
engedélyezi, a program Felügyelei üzemmódban az eseményeket folyamatosan 
hozzáfűzi a *.rcp fájlhoz. T&A szoftver használatakor a PR Master lehetővé 
teszi különböző fájl típusok kiválasztását. Az esemény tár minden olvasási 
folyamata aktualizálja ezt a fájlt. 

Lásd még: 

T&A Jelentés 



 

 

XML jelentések és e-mail 

A PR Masterben XML jelentéseket hozhatnak létre az időzítőnek megfelelően.   
Az XML jelentés a legutolsó jelentéskészítéstől számítva az összes eseményt 
tartalmazza. Egy kiválasztott mappába kerülnek az elmentett fájlok, a fájlnév a 
dátumot és az időt is tartalmazza. A Run report now / Jelentés futtatása most 
funkció segítségével bármikor létrehozhat egy jelentést. 



 

Csatolt fájlként e-mailben is el lehet küldeni a jelentéseket. Ehhez válassza a 
Send XML report as e-mail attechment / XML jelentés e-mailben csatolt 
fájlként opciót, majd konfigurálja az e-mail beállításokat. 

Kövesse a következő lépéseket: 

Először adja meg a Mail Server (SMTP) fül alatt lévő adatokat. 

 

Kattintson az E-mail settings / E-mail beállítások  fülre. 



Töltse ki a címzetteket, és állítsa be az üzenet prioritását. Ha a Request Reciept 
Confirmation / Visszajelzés kérése opciót engedélyezi, akkor a címzettől 
visszajelzésre lesz szükség. 

 

Ha az e-mail f iók megfelelően lett kialakítva, akkor a jelentést elküldi a 
kiválasztott címzetteknek a rendszer. A következő lépés az XML fájlok lemezre 
mentése. 

 

Misc / Egyéb 

Az egyéb program opció lehetővé teszi: 

• Disable DURESS codes / Kényszerített kódok tiltása 

Ha a felhasználó az eredeti PIN kódjánál eggyel kisebb, vagy eggyel 
nagyobb számot üt be, akkor a vezérlő azt kényszeríttet kóddal való 
belépésként értelmezi. Kényszeríttet belépés esetén megjelenik egy 
KÉNYSZERÍTETT esemény, és a kimeneten egy ERŐSZAKOS 
BELÉPÉS jel. 

Példa: 

Ha az eredeti kód [4569] és a beütött kód [4568][#] vagy [4560][#], 
akkor az kényszeríttet belépésnek számít. 

• Event downloaded from networks only upon operator’s request/ 
Hálózatról történő eseményletöltése kizárólag kezelő kérésére 
(parancsra) 



Az opció engedélyezésére az események nem töltődnek le 
automatikusan az esemény tárból, hanem a vezérlőn tárolt 
eseményeket az operátornak manuálisan kell letöltenie. 

• Disable APB Hierarchy / APB Hierarchia kikapcsolása 

Lásd még: 

Vezérlő tulajdonságai – Kényszerített 

 

Kártyák 

 

Konfiguráció mentése 

A PR Master-ben a felhasználó automatikus mentést is beállíthat. Ez egy 
esetlegesen előforduló adatvesztéstől vagy adatbázis összeomlástól védi a 
felhasználót. Beállítható, hogy meghatározott időben készítsen mentéseket: 
napra, órára vagy azonnal [Run backup now / Mentés futtatása azonnal]. 

Automatikus mentés engedélyezéséhez: 

• Ellenőrizze az Enable Autobackup / Automatikus mentés 
engedélyezése opciót 



• Adja meg az időpontot, majd válassza ki a napokat, amikor a mentést 
futtatni kívánja 

• Válassza ki a régi események eltávolításának módját 

• Válassza ki a menteni kívánt adatokat (Configuration data / Adat 
konfiguráció, Events History / Esemény napló) 

• Válassza ki a kimeneti fájl típusát, és adja meg a ZIP fájl jelszavát 

• Válassza ki a mentés helyét 

A PR Masterben a régi események két módon távolíthatóak el: 

• Meghatározott számú napnál régebbi események eltávolítása 

• Meghatározott számú események megtartása 

 



Groups / Csoportok  

 

A RACS rendszernél egy felhasználó 250 felhasználói csoportba is tartozhat. A 
felhasználói csoport meghatározza a felhasználó jogait. A felhasználói csoport 
minden tagja egyenlő belépési jogokkal rendelkezik minden zónába. Speciális  
esetekben egy csoport egy felhasználót is jelenthet. Az egy hetes periódusban 
meghatározott időzítőktől függően a csoporttagok belépési engedélyt kaphatnak 
a különböző zónákba. A csoportoknak arra a 16 emeletre is van belépési joguk,  
amelyet nem ellenőriz semmilyen időzítő. 

Az újonnan regisztrált felhasználók nem tartoznak egyetlen rendszer csoportba 
sem, időkorlát nélkül korlátlan belépési engedéllyel rendelkeznek (az összes 
emeletre és zónába), és az úgynevezett [No group / Nincs csoport] csoportba 
tartoznak. Minden felhasználót különböző csoporthoz lehet rendelni. 

A rendszer felhasználók kizárólag a következő esetekben veszíthetik el a 
belépési jogaikat: 

• A bemeneti vonal  a No.11 Access denied / Belépés letiltva funkcióra lett 
konfigurálva és aktív állapotba került 

• Az ajtó üzemmód zártra lett állítva 

• A vezérlő ÉLESÍTETT állapotban van és az Access disabled when 
controller ARMED / Belépés tiltva, amikor a vezérlő élesített opció 
engedélyezett 

Megjegyzés: 

A PR Masternek a [No group / Nincs csoport] csoportja egy olyan előre definiált 
csoport, amely teljes belépési joggal rendelkezik. Régebbi típusú vezérlők 
(PRxx1) esetén csak 31 felhasználói csoport definiálható. 

Lásd még: 

Add access groups / Felhasználói csoportok hozzáadása 

Group properties / Csoport tulajdonságok 

 



Add access goups / Felhasználói csoportok hozzáadása 

Új csoportot a következő két üzemmódon lehet létrehozni: 

• Kattintson a   gombra az operátor eszközökben a főmenüben, 
vagy válassza a menüből Edit -> Groups / Szerkesztés -> Csoportok 
menüpontot 

• Kattintson az Add/Hozzáadás gombra 

 

Csoport tulajdonságok 

 

Csoport tulajdonságok  

A Csoport tulajdonságokban meg kell határozni a belépési jogokat az összes 
zónába és a 16 emeletre. 

Az időzítők zónához rendeléséhez a következőképpen jár jon el: 

• Válassza ki a zónát 

• Kattintson az Edit / Szerkesztés gombra 

• Válassza ki az időzítőt 

• Kattintson az OK gombra 

Az Elevator Level Access settings / Felvonó szint beléptető beállításai alatt a 
megfelelő szintek kiválasztásával lehet meghatározni, hogy mely szintek 



legyenek a csoport számára elérhetőek. Engedélyezni kell a Vezérlők 
tulajdonságai ablakban az Opciók fülön az Enable XM-8 elevator control 
module(s) / XM-8 felvonó vezérlő modul engedélyezése opciót. 

Megjegyzés: 

1. A PR Master 0-15-ig 16 emeletet képes kezelni. A vezérlőhöz 
csatlakoztatni kell az XM-8 Bemeneti/Kimeneti bővítő modult. 

2. Az emeletekre a belépés i jogok nem változtathatóak (időzítők által nem 
korlátozható) 

 

 

Időzítők: A Mindig (a belépés mindig engedélyezett) és Soha (a belépés soha 
sem engedélyezett) időzítők a programban előre definiáltak.  Újabb időzítők 
kiválasztásához a Time Schedule / Időzítőknél létre kell azokat hozni. 

Kattintson az All always / Összes mindig és az All never / Összes soha gombra 
az összes zóna időzítőjének megváltoztatásához. 



 

 

Felhasználók: 

 

A Roger Beléptető rendszer akár 4000 felhasználó regisztrálására is alkalmas. 
Az összes felhasználó azonosító számmal rendelkezik (ID) és a négy előre 
definiált felhasználótípus egyike lehet. A beléptető rendszer vezérlők egyéni 
azonosítók segítségével azonosítják a felhasználókat. A Roger Beléptető 
rendszerben ez az azonosító egy transzponder (proximity kártya), vagy egy PIN 
kód lehet. Lehetőség van az úgynevezett dupla azonosítási üzemmód beállítására 
is (kártya és PIN kód), amely lehetővé teszi a felhasználók számára mindkét 
azonosítási üzemmód használatát. A sorrend nem számít. Minden azonosító 
létrehozható korlátlan időre vagy maximum 12 hónapos időre (a kezdő dátumtól 
a lejárat dátumáig) Edit users / Felhasználók szerkesztése. Lehetséges a 
kártyahasználat limitálása is. A kártyahasználat limitálásához a rendszer összes 
vezérlőjén ezt végre kell hajtani.  Amikor a felhasználó érvényességi ideje lejár,  
vagy a kártyahasználat elér i a megadott értéket, a vezérlő automatikusan 
eltávolítja az érvényes azonosítók listájából. Az azonosító további használatára 
nincs lehetőség. 



 

 

Add / Hozzáadás - új felhasználó hozzáadása (a program akár 4000 felhasználót 
is képes regisztrálni) 

Delete / Törlés – kiválasztott felhasználó törlése a listából 

Edit / Szerkesztés – felhasználói beállítások megváltoztatása 

Delete all / Összes törlése – összes felhasználó törlése a listából 

Change type / Típus megváltoztatása – felhasználói típus megváltoztatása: 
Master / Mester, Switcher Full / Teljes kapcsoló, Switcher Limited / Korlátozott 
kapcsoló, Normal / Normál 

Change ID / Azonosító megváltoztatása – felhasználói azonosítószám 
megváltoztatása 

Export – felhasználói lista exportálása „csv” fájlba 

Import – felhasználói lista importálása „csv” fájlból 

Megjegyzés: 

Az Import opció segítségével a meglévő felhasználói listához újabb felhasználó 
csatolható. 



Add users / Felhasználók hozzáadása 

Új felhasználó hozzáadásához válassza ki a Felhasználók ablakból az Add / 
Hozzáadás menüpontot. 

 

Válasszon egyet a következő 4 felhasználó típus közül: 

MASTER / MESTER – ajtónyitás i engedély, BE/KI üzemmód kapcsolása, és 
kézi programozó üzemmód megadása (azonosító szám 0) 

SWITCHER FULL / TELJES KAPCSOLÓ –ajtónyitási engedély, BE/KI 
üzemmód kapcsolása (azonosító szám 1-től 49-ig) 

SWITCHER LIMITED / KORLÁTOZOTT KAPCSOLÓ – az ajtónyitás nem 
engedélyezett, kizárólag az ajtó üzemmódjának beállítására van engedélye 
(azonosító szám 50-től 99-ig) 

NORMAL / NORMÁL – csak ajtónyitási engedély (azonosító szám 100-tól 
3999-ig) 

A felhasználói típus kiválasztása után kattintson az OK gombra. Ekkor 
megjelenik a felhasználói tulajdonságok ablak (User properties / Felhasználói 
tulajdonságok) 

Megjegyzés: 

Az 1000-től 3999-ig ter jedő azonosító számmal rendelkező felhasználók szintén 
kinevezhetőek Local SWITCHER / Helyi kapcsolóknak bizonyos vezérlőn vagy 
vezérlőkön. 

Lásd még: 

Advanced / Haladó 



User properties / Felhasználói tulajdonságok: 

A felhasználói tulajdonságok ablak tartalmazza a rendszer felhasználókkal 
kapcsolatos összes információt. 

 

 

A rendszerfelhasználó konfigurálása: 

• User Valid / Érvényes felhasználó opció engedélyezése 
• Töltse ki az adatokat: First Name / Keresztnév, Last Name / Vezeték név 
• A felhasználót úgy rendelheti egy már létező felhasználói csoportba, hogy 

a görgő segítségével a Group / Csoport menüpontból kiválasztja a 
megfelelő csoportot 

• Adja meg a PIN kódot, majd erősítse azt meg 
• A lenti módszerek egyikével a Kártya kódot rendelje egy felhasználóhoz 

 

 

 



Opcionálisan: 

• Fénykép betöltése fájlból, vagy fénykép készítése USB kamera 
segítségével 

• Engedélyezze a User Activity Period / Felhasználó aktív időtartama 
opciót és adja meg a kezdő, és a lejárati dátumot a naptár segítségével 

• Comments - Megjegyzések írása 
 

Kétféle módszerrel lehet kártyához felhasználót rendelni: 

• Automatikus kártyakód leolvasás a kiválasztott olvasón. Kattintson a 
Read Card / Kártya olvasása gombra, válassza ki a vezérlő nevét és  
közelítse a kártyát az olvasóhoz. Miután a rendszer a kártyát beolvasta, a 
program visszatér a Felhasználói tulajdonságok ablakba, és a kártya kód 
bekerül a helyére. 

• Card box / Kártya dobozból. Kattintson a kártya dobozra és válassza ki a 
megfelelő kártyát. A Kártya doboz az eddig bevitt kártyákat tartalmazza.  
Lehetőség van a felhasználók által már lefoglalt kártyák Hozzáadására, 
Törlésére, és Ellenőrzésére. 

 

Megjegyzés: 

1. Ha a felhasználói kártya első alkalommal lett regisztrálva, akkor a kártya 
kódját egy olvasóval be kell olvastatni. 

2. Gyakran olyan számok is találhatóak a kártyán, amelyek más cégtől 
származnak, azonban ezek nem RACS azonosító számok. 

3. Az a felhasználói típus, amelyik Teljes vagy Korlátozott kapcsoló típusú 
az nem lehet Helyi kapcsoló típusú. 

 



Kártya kód beolvasása 

 

A kártya kódjának beolvasása előtt válassza ki azt a vezérlőt, amelyiken a 
kártyát le szeretné olvastatni. Kattintson a Read / Olvasás gombra és közelítse a 
transzpondert a kiválasztott vezérlőhöz. 

 
Delete users / Felhasználók törlése 

A felhasználó listából történő eltávolításához a lenti módszerek egyikét 
alkalmazza: 

• Nyissa meg a User list / Felhasználói listát 
• Válassza ki a felhasználót és kattintson a Delete / Törlés gombra 
• A megerősítéshez kattintson az Yes / Igen gombra 
• A felhasználói kártya visszakerüljön a Kártya dobozba? Kattintson az 

Igenre vagy a Nemre. 
•  

 

• Zárja be a Felhasználói listát és küldje el a konfigurációt a rendszernek 
(főmenü: Commands-> Update system / Parancsok -> Rendszer frissítés) 

 

Vagy 



• Nyissa meg a Quick User Update / Felhasználó gyors frissítése 
menüpontot 

• Válassza ki a felhasználót és kattintson a Delete / Törlésre 
• A megerősítéshez kattintson a Yes / Igenre 
• A felhasználói kártya visszakerüljön a Kártya dobozba? Kattintson az 

Igenre vagy a Nemre. 
• Kattintson az OK gombra a rendszer konfigurálás i frissítés 

megerősítéséhez 
 

Megjegyzés: 

A törölt felhasználó a rendszer adatbázisában marad, így olyan eseményre is  
lehet keresni, amelyben a törölt személy részt vett. 

 

Törölt felhasználók listázása: 

• Válassza a Edit / Szerkesztés menüpontot a főmenüből, majd a Users / 
Felhasználók menüpontot 

• Jelölje ki a Show deleted users / Törölt felhasználók megjelenítése 
opciót 

 
A felhasználók adatbázisból való végleges törléséhez jelölje ki a Törölt 
felhasználók megjelenítése opciót, kattintson a Töröltek eltávolítása gombra, 
majd nyomja meg az OK gombot a megerősítéshez. 
 

 

Ütemezők 

 

Az időzítő egy előre meghatározott időperiódus (-tól…-ig…) a hét minden 
napjára (hétfőtől péntekig), és az ünnepnapokra (H1;H2;H3;H4). Az időzítők 
segítségével a RACS rendszerben egy hetes periódusban speciális műveletek 
végezhetőek. 



Az időzítők öt típusa: 

• APB reset schedules / APB törlés időzítése 

• Door mode schedules / Ajtó üzemmód időzítők 

• Identification mode schedules / Azonosítási üzemmód időzítők 

• Genereral purpose schedule / Általános célú időzítő 

• T&A mode schedules / T&A üzemmód időzítők 

• Topic_Identification Mode Schedule / Téma azonosító üzemmód időzítő 

Új időzítő meghatározása: 

• Kattintson az Schedules / Időzítők ikonra, vagy válassza a 
Edit>Schedules / Szerkesztés-> Időzítők menüpontot a főmenüből 

• Az öt lehetséges fül közül kattintson az egyikre 

• Kattintson a Add / Hozzáadás gombra 

 

 

General purposes schedules / Általános célú időzítők 

Az általános célú időzítő a vezérlő egy vagy több feladatát látja el. PL ugyanaz 
az időzítő alkalmazható egy időben egy meghatározott zóna csoportos beléptetés 
ellenőrzésére, a [#] Billentyűzet opc ióra, a vezérlő bemeneti vonalára és  



feltételes üzemmódjára. A PRxx2 vezérlő akár 99 ilyen típusú időzítőt is  
kezelhet. Az általános célú időzítőknek nincs egy meghatározott célja. 

 
Az időzítőknek 2 alapértelmezett típusa van. Az Always / Mindig és a Never / 
Soha. Új időzítő meghatározásához kövesse a következő lépéseket: 

• Adja meg az időzítő Name / Nevét 

• Válasszon napot (hétfőtől - vasárnapig) a lehetséges fülek egyikére 
kattintva 

• Kattintson az Add / Hozzáadás gombra 

• Határozza meg a Start time / Kezdő időt és az End time / Végső időt 

• Kattintson az OK gombra a megerősítéshez 

Az általános célú időzítők a következő ellenőrzésekre szolgálnak: 

• Csoportos belépések a zónákba 

• A bementi és kimeneti vonalak működtetése 

• [F1]-[F4] billentyűk működtetése 

• A billentyűparancsok működtetése 

• Élesített / Hatástalanított üzemmód 

• [#] billentyű opció 

• Magas biztonsági opció működtetése 



• Facility kód opció működtetése 

• (kártya+kártya) opció működtetése 

• Kapcsoló felhasználók működtetése 

• Kemény APB / Lágy APB opció 

• Feltételes belépési opció működtetése 

Beillesztés – időperiódusok átmásolása más napokból 

Összes törlése – az időzítő összes meghatározott időperiódusának törlése 

Import – meglévő időzítőkből időperiódusok importálása. Csak azonos típusú 
időzítők beállításainak importálása lehetséges. 

Megjegyzés: 

Más időzítőből való időperiódus importálás törli a meglévő beállításokat. 

 

 

APB törlés időzítők 

APB törlés időzítők az Anti-Passback bejegyzések törlésére szolgálnak. Miután 
mindegyik felhasználót törölte, az APB bejegyzések nem meghatározott 
állapotot kapnak (nem lehet ellenőr izni, hogy a felhasználó hol jelentkezett be 
legutoljára, belépésnél vagy kilépésnél). A „Törölt” állapotú felhasználó 
belépésnél és kilépésnél egyaránt használhatja az azonosítóját. Az első belépés  
után a vezérlő újra elkezd az APB szabályok szerint működni.   
Az APB törlés időzítő meghatározásakor ugyanúgy kell eljárni, mint az 
általános célú időzítők esetén, kivéve, hogy az APB törlés idejét is be kell 
állítani. 



 

Lásd még: 

Beillesztés, Összes törlése, Import 

 

Ajtó üzemmód időzítők 

Az Ajtó üzemmód időzítő lehetővé teszi a vezérlő ajtó üzemmódok közötti 
automatikus átkapcsolását. Az Ajtó üzemmód meghatározza, hogy a vezérlő 
áram alá helyezze, vagy áramtalanítsa az ajtózárat. Az ajtózár a következő 
működési üzemmódokba állítható be: 

• Normal / Normál – Az ajtózár azután lép működésbe, miután a vezérlő 
engedélyezi a belépést 

• Unlocked / Nyitott – Az ajtózár folyamatosan áram alatt van, az ajtót 
bárki ki tudja nyitni 

• Conditional Unlocked / Feltételesen nyitott – Az ajtó alapvetően nincs  
árammal ellátva, de miután az első erre felhatalmazott személy használja 
az azonosítóját az ajtó áram alá kerül, és ebben az állapotban marad az 
újabb ajtó üzemmód beállításáig. 

• Locked / Zárt – Az ajtózár aktiválása tiltott, nem számít, hogy a 
felhasználónak van belépés i jogosultsága vagy nincs, minden ajtónyitás i 
kísérlet sikertelen lesz. 



 

Az ajtóüzemmód időzítő meghatározása: 

• Adja meg az időzítő Name / Nevét 

• Válasszon napot (hétfőtől péntekig) a lehetséges fülek egyikére 
kattintva 

• Kattintson az Add / Hozzáadás gombra 

 

• Határozza meg a Start time / Kezdő időt és az End time / Végső időt 

• Válasszon ajtó üzemmódot a menüből: [Unlocked]/ [Be nem zárt], 
[Locked]/[Bezárt], [Cond.Unlocked]/[Feltételesen be nem zárt] 

• Kattintson az OK gombra 

Megjegyzés: 

A meghatározott periódusok között a vezérlő visszatér [Normál] ajtó 
üzemmódba. 



Lásd még: 

Beillesztés, Összes törlése, Import 

Azonosítási üzemmód időzítő 

Azonosítási üzemmód időzítő lehetővé teszi a vezérlő számára az azonosítási 
üzemmódok közötti automatikus átkapcsolást. Ennek az időzítőnek a 
meghatározása hasonló az Általános célú időzítőhöz, kivéve, hogy az 
azonosítási üzemmódok előre be vannak állítva. Négy azonosítási üzemmód 
lehetséges: 

• Kártya és PIN kód 

• Kártya vagy PIN kód 

• Csak kártya 

• Csak PIN kód 

Az összes időperiódus meghatározása után össze kell rendelni az időzítőt a 
kiválasztott olvasóval. Nyissa meg az Edit -> Networks ->Controllers-
>Properties->Terminal ID1/TerminalID0 / Szerkesztés -> Hálózatok -> 
Tulajdonságok -> Olvasó ID1/Olvasó ID0 menüt és válassza ki az azonosítási 
üzemmódot a legördülő menüből. 

 

Megjegyzés: 

A meghatározott periódusok között a vezérlő automatikusan visszatér az 
alapértelmezett Azonosítási üzemmódba. 



Lásd még: 

Beillesztés, Összes törlése, Import 

T&A üzemmód időzítők: 

A T&A üzemmód időzítő lehetővé teszi a vezérlő számára a T&A üzemmódok 
közötti automatikus átkapcsolást. Ennek az időzítőnek a meghatározása hasonló 
az Általános célú időzítőhöz, kivéve, hogy a T&A üzemmódok előre be vannak 
állítva. 

T&A üzemmód időzítők meghatározása: 

• Adja meg az időzítő Name / Nevét 

• Válasszon napot (hétfőtől - péntekig) a lehetséges fülek egyikére 
kattintva 

• Kattintson az Add / Hozzáadás gombra 

• Határozza meg a Start time / Kezdő időt és az End time / Végső időt 

• Válasszon T&A üzemmódot a legördülő menüből 

• Kattintson az OK gombra a megerősítéshez 

 

 



Az időperiódusok meghatározása után: 

• Nyissa meg az Edit -> Networks-> Controllers-> Properties-> Options /  
Szerkesztés -> Hálózatok -> Vezérlők -> Tulajdonságok -> (Opciók fül) 

• Jelölje be az Enable T&A Schedule / T&A időzítők engedélyezése opciót 

Megjegyzés: 

1. A meghatározott periódusok között a vezérlő automatikusan visszatér az 
alapértelmezett T&A üzemmódba. 

2. Négy előre definiált T&A üzemmód van: Belépés, Kilépés, Hivatalos  
kilépés és Nem T&A (Elutasított). Saját T&A üzemmódok meghatározása 
is lehetséges, amelyeket időperiódusokhoz lehet rendelni. Újabb T&A 
üzemmód hozzáadásához válassza a  Tools -> T&A modes / Eszközök -> 
T&A üzemmódok menüpontot. 

Lásd még: 

Beillesztés, Összes törlése, Import 

Zónák 

 

Belépési zóna – kiválasztott azonosítási pontok összessége (beépített olvasókkal 
rendelkező vezérlők, vagy belépési terminálok), amelyek a beléptető 
rendszerben egy összefüggő területként értelmezhetőek. Egy példa a belépés i 
zónákra: Gyártási terület, Iroda, Munkaterület, Raktárépület, Emelet, stb... 

Általában a belépési zónák célja, hogy a meghatározott belépési jogokkal 
történő műveletek sokkal egyszerűbbek legyenek. A zónáknak köszönhetően a 
belépési jogokat nem csak egy belépési pontra lehet kiadni (egy ajtó), hanem 
több eszköz számára is (vezérlők/terminálok), amelyek így egy meghatározott 
területen ellenőrzik a belépést. 

Speciális esetben minden belépés i pont egy külön belépési zóna lehet. Ebben az 
esetben a belépés i jogok egy ajtóra, vagy egy útvonalra vonatkoznak. Minden 
vezérlőt egy korábban már létrehozott belépés i zónához kell rendelni. Az 
újonnan létrehozott vezérlők az Alapértelmezett zónához tartoznak. 

Olvasó hozzáadása a belépés i zónához: válassza az Edit->Network-
>Controllers->Properties->Terminal ID1,Terminal ID0 / Szerkesztés -> 



Hálózatok ->Vezérlők ->Tulajdonságok -> Terminál ID1,Terminál ID0 
menüpontot és ott válassza ki az Access Zone / Belépési Zónákat a menüből. 

Belépési zóna hozzáadása 

Új belépési zóna hozzáadásához: 

• Kattintson a  ikonra az eszközöknél, vagy válassza az Edit-> 
Zones / Szerkesztés ->Zónákat a főmenüből 

• Kattintson az Add / Hozzáadás gombra 
• Adja meg a zóna Name / Nevét 
• Kattintson az OK gombra 

 
 

Megjegyzés: 

Az [ALAPÉRTELMEZETT] (0) egy előre beállított zóna, amely nem 
szerkeszthető és nem is törölhető. 

 



 

Hálózatok 

 

A Roger Beléptető rendszer vezérlő központokból CPR (max 10), PR 
vezérlőkből, és PRT terminálokból áll. Mindegyik vezérlő központ 32 beléptető 
vezérlőt működtethet. A hálózat, vagy alrendszer vezérlő központból,  
vezérlőkből, és terminálokból épül fel. 

Ebből az ablakból az összes hálózatot, vezérlő központot, parancsok küldést és 
rendszerfrissítést konfigurálhatja. 

A lehetséges opciók leírása: 

• Add network / Hálózat hozzáadása – új hálózat hozzáadása (Új hálózat 
hozzáadása  fejezet alatt található) 

• Delete network / Hálózat törlése – ha a hálózat nem üres, akkor először 
a vezérlőket kell törölni 

• Properties / Tulajdonságok – a kiválasztott hálózat szerkesztése 
(kommunikációs port megváltoztatása, port beállítása) 

• Controllers / Vezérlők – vezérlő lista megnyitása 
• CPR – Vezérlőközpont opciók 
• Commands / Parancsok – parancs küldése az összes vezérlőnek 

 

Lásd még: 

Új hálózat hozzáadása 



 

Hálózati tulajdonságok 

UT-2 illesztőhöz kapcsolódó új hálózat hozzáadásához: 

 



 

• Kattintson a  ikonra az eszközöknél, vagy válassza ki az Edit -
>Networks / Szerkesztés -> Hálózatok menüpontot 

• Kattintson az Add Network / Hálózat Hozzáadása gombra 
• Adja meg a hálózat Name / Nevét 
• Válassza ki a Communication port / Kommunikációs portot – COM 
• Engedélyezze a Network equipped with control panel / Vezérlő 

központtal összekötött hálózat opciót, ha van CPR eszközt csatlakoztatott 
• Kattintson az OK gombra 

 

A Hálózati konfiguráció befejezése után kattintson a Controllers / Vezérlők-re, 
amivel megkezdi az eszközök keresését. 

A lehetséges opciók leírása: 

• Network active / Hálózat aktív – aktivált, vagy nem aktivált hálózat 
• Network equipped with control panel / Vezérlő központtal összekötött 

hálózat – engedélyezze, ha van csatlakoztatott vezérlő központ 
• Enable Armed / Disarmed mode control for PRxx1 series / 

Élesített/Hatástalanított üzemmód ellenőrzése a PRxx1 sorozat számára 
– amennyiben van csatlakoztatott PRxx1 típusú vezérlő 

 

Az UT-4-en kommunikációs egységen keresztül összekötött hálózat kibővíti a 
RACS rendszer lehetőségeit. Ebben a konfigurációban lehetőség van a RACS 
rendszer konfigurálására és felügyeletére távolról, és helyi hálózaton keresztül 
(WAN) vagy (LAN). UT-4-gyel ellátott rendszer lehetővé teszi a RACS 
rendszer adatbázisának megosztását. 



 

 

Új UT-4 egységgel összekötött hálózat hozzáadása: 

• Kattintson a  ikonra az operátor eszközöknél, vagy válassza ki a 
Edit->Networks / Szerkesztés -> Hálózatok menüpontot 

• Kattintson a Add Network / Hálózat Hozzáadása gombra 
• Adja meg a hálózat Name / Nevét 
• Engedélyezze Network equipped with control panel / Vezérlő központtal 

összekötött hálózat opciót, ha van csatlakoztatott CPR eszköz 
• Válassza ki a Communication port / Kommunikációs portot – TCP/IP 
• Adja meg a Communication port timeout / Kommunikációs port 

időtúllépés idejét 
• Kattintson a Find / Keresés gombra az UT-4 eszközök kereséséhez (UT-4 

konfiguráció fejezet) 
 



Az illesztő IP címének kompatibilisnek kell lennie a hozzá csatlakoztatott 
hálózat IP címével. Az IP cím megadása esetén, ne felejtse el, hogy az UT-4 
alapértelmezett portja a 1001-es. 

Ha nem ismeri az IP címezés szabályait, lépjen kapcsolatba a hálózat 
adminisztrátorával. 

Megjegyzés: 

Az eszköz IP címének utolsó 3 számjegyének különböznie kell a számítógép IP 
címének utolsó 3 számjegyétől. Például, ha 192.168.0.100 a számítógép IP címe, 
akkor az eszköz IP címe 192.168.0.xxx kell legyen, ahol az xxx egy egyedi 
szám a helyi hálózatban (0-tól 255-ig terjedő tartományban). Ez azt jelenti, hogy 
egyetlen más eszköznek sem lehet ugyanez az IP címe. 

Lásd még: 

UT-4 konfiguráció 

CPR nélküli rendszer 
 

UT-4 konfiguráció 

Ez az alkalmazás lehetővé teszi helyi hálózat keresését, (LAN) auto-discovery 
by broadcast / automatikus adás keresés módszerrel, vagy (WAN) belépés i IP 
cím(ek) Címjegyzékbe való hozzáadásával. 

LAN hálózatban mindkét módszer használható, de nem lehet az automatikus  
adás keresés módszert használni, ha az UT-4 WAN hálózathoz van kötve. 

Az eszközkeresésnek két típusa létezik: 

• Automatikus adás keresés (csak LAN-ban való keresésre) 
• Címjegyzékből (LAN-ban vagy WAN-ban való keresésre) 

 

A keresési folyamat befejeztével megjelenik az eszközök listája. 



 

 

Leírás: 

• DS beállítások – az UT-4 haladó beállításai 
• Initialize / Inicializál – a beállítások törlése, majd visszaállítása 

alapértelmezettre 
 

Network properties / Hálózati tulajdonságok 

Lehetővé teszi a Hálózati Tulajdonságok megváltoztatását. Az UT-4-hez való 
hozzáférés jelszóval védett. Az összes beállítás elmenthető és betölthető *.ds  
kiter jesztésű fájl használatával. Megváltoztathatja az UT-4 illesztőegység IP 
címét és az Ethernet címét. 



 

Megjegyzés: 

Az IP cím megváltoztatása kommunikációs problémát okozhat, és meggátolhatja 
az eszköz elérését. Az [Ethernet-cím] megváltoztatása nem javasolt és szinte 
soha nem szükséges. 

 

DIGI konfiguráció 

Telepítés Microsoft XP operációs rendszerre 
 

A DIGI konfiguráció a RACS 4.2 szoftvercsomag része. A Digi Eszköz 
Varázs ló (digi konfigurátor) segítségével könnyen konfigurálható. Az eszközhöz 
rendel egy IP címet, az eszköz környezetének leírásán alapuló eszközt 
konfigurálja, és meghatározza, hogy kell-e telepítenie a RealPort-ot. 

• A Digi Konfigurátor futtatásához kattintson a menüben a Start-> All 
programs->Roger ACS 4.2 -> Digi Configurátor / Start -> Minden 
program -> Roger ACS 4.2 -> Digi Konfigurátor 



 
 
• Kezdés előtt bizonyosodjon meg róla, hogy: 

1. A Digi Connect / Digi Kapcsolat csatlakoztatva van-e a hálózathoz 
és be van-e kapcsolva 

2. Feljegyezte a Digi Connect / Digi Kapcsolat MAC címét, mely az 
eszköz alján vagy a hátoldalán található. Erre a címre szükség lesz, 
hogy ki tudja választani az eszközt a megjelenő eszközök listájából,  
amely a következő lépésnél fog megjelenni. 

• Kattintson a Next / Következő gombra a folytatáshoz, és ez az ablak 
jelenik meg: 



 

• Válassza ki a megfelelő eszközt a listából. Újabb eszközök 
megjelenítéséhez kattintson a Frissítésre. 

 

Amennyiben az eszköz: 

• Feketén van kijelölve, ha a varázsló teljes mértékben támogatja azt. 
• Szürkén van kijelölve, ha az IP cím, subnet mask, és az alapértelmezett 

gateway konfigurálható, de a varázsló nem támogatja a többi opc ió 
konfigurálását. 

• Pirossal van kijelölve és a <nem konfigurált> felirat látható, ha a DHCP 
be van kapcsolva és nincs DHCP szerver a hálózaton 

• Pirossal van kijelölve és a <nem konfigurált> felirat látható, ha az eszköz 
már konfigurálva lett és az IP cím beállítás nem működik azon a címen, 
ahova az eszköz csatlakoztatva lett. 

• Nincs megjelenítve, ha a varázsló nem találja. 
• Kattintson a Next / Következő gombra a folytatáshoz, és ez az ablak 

jelenik meg: 



 

 

• Válassza az Obtain IP Address settings automatically using DHCP / 
Automatikus IP cím kérés DHCP használatával opciót– ez az opció 
DHCP szervert igényel, amely megadja a hálózati beállításokat. A Digi 
Connect / Digi Kapcsolat a DHCP klienssel engedélyezett, ezért ha 
rendelkezik DHCP szerverrel, válassza ezt a beállítást és a Digi Connect / 
Digi Kapcsolat hálózati beállításokat kér a szervertől. 

• Vagy válassza a Use the following IP settings / Használja a következő IP 
beállításokat opciót – kérje el a hálózati adminisztrátortól a hálózati 
beállításokat, és a megadott adatokat gépelje be a megfelelő helyekre. Az 
IP cím és a subnet mask megadása kötelező, a többi opcionális. 

• Kattintson a Next / Következő -> gombra a folytatáshoz, és ez az ablak 
jelenik meg: 



 
 

• Válassza a RealPort (COM Port Redirection) opciót. A 
RealPort®technológia, a RACS alkalmazáshoz egy virtuális soros portot 
hoz létre. Ez azt jelenti, hogy a Windowsban (vagy egy másik operációs 
rendszerben) az alkalmazás úgy látja, mintha a COM1-nek megfelelő 
valós soros portot kezelne, és ezen keresztül átirányítja, vagy elküldi az 
összes információt a hálózaton keresztül az eszköz szerverre. Ezt Virtuális  
Soros Portnak nevezik. 

• Kattintson a Next / Következő -> gombra a folytatáshoz, és ez az ablak 
jelenik meg: 



 
 
• Engedélyezze az Install Digi RealPort on this computer / A Digi RealPort 

telepítése erre a számítógépre opciót 
• Kattintson a Next / Következő -> gombra a folytatáshoz, és ez az ablak 

jelenik meg: 



 

• Mielőtt felölti az eszközre a konfigurációt, ellenőr izze azt. Az összes 
korábbi beállítás törlődni fog, mielőtt az új beállítások érvénybe lépnek.  
Későbbi célokra a konfigurációs jelentés lementhető lemezre. 

• A beállítások mentéséhez kattintson a Next / Következő gombra és ez az 
ablak jelenik meg: 



 

• Ez az oldal megmutatja az eszköz konfigurációs beállítások 
alkalmazásának folyamatát. A konfiguráció elküldése után, a következő 
ablak jelenik meg: 



 
 

• A konfigurációs folyamat befejeztével, kattintson a Finish / Befejezés  
gombra a Digi Device Setup Wizard / Digi Eszköz Telepítés Varázs ló 
bezárásához. 

A Digi Connect Me / Digi Kapcsolat ME konfigurálásához használhatja a webes 
elérést is. A webes eléréséhez engedélyezze a Log on the web user interface of  
device / Bejelentkezés az eszköz webes felületére opciót, és kattintson a Finish / 
Befejezés gombra vagy adja meg az IP címet a webböngészőjében. 

 

Telepítés Microsoft Windows 98 vagy Microsoft Windows Me operációs 
rendszerre 

A RealPort telepítéséhez kövesse a következő lépéseket: 

• Kattintson a Startra, majd a Settings / Beállításokra végül a Control 
Panel / Vezérlőközpontra 

• Kattintson duplán az Add new Hardware wizard/ Új hardware 
hozzáadása varázslóra, hogy az Új hardware hozzáadása Varázs ló 
elinduljon. Kattintson a Next / Következő gombra, majd újra a Next / 
Következő gombra. 

Megjegyzés : Új hardware hozzáadása varázsló új eszközöket keres. 



• Ha látja az Is the device that you want to install listed below? / Listázva 
van a telepíteni kívánt eszköz? üzenetet kattintson a No, the device isn’t 
int the list / Nem, az eszköz nincs a listában-ra, majd a Next / Következő 
gombra 

• Kattintson a No, I want to select the hardware from a list / Nem, a 
listából választom ki az eszközt, majd a Next / Következő gombra 

• A Hardware types list / Hardver típusok listájában válassza az Other 
devices / Egyéb eszközöket és kattintson a Next / Következő gombra 

• Kattintson a Have disk / Lemez -re 
• Adja meg a RealPort fájlok elérési útvonalát és kattintson az OK gombra,  

vagy a Browse / Keresés gombra és helyezze el a fájlt. 
 

Megjegyzés: 

A legújabb drivereket és firmwareket megtalálja a gyártó weboldalán,  
www.digi.com 

• A Models list / Modellek listájában, válassza ki az azt eszközt, amit 
telepít: Digi Connect ME / Digi Kapcsolat ME, kattintson a Next 
/Következő gombra, majd a Finish / Befejezésre. 

• Kövesse a képernyőn látható utasításokat a RealPort telepítésének 
befejezéséhez. 

 

CPR konfigurálása a hálózatban 

A CPR fő funkciója a Roger Beléptető Rendszer részét képező autonóm 
eszközök kezelése, valamint munkájuk koordinálása. 

CPR működési üzemmódok 
 

A vezérlő központ (CPR) két fő működési üzemmódja az [ON] és az [OFF] 
üzemmód. Az [ON] üzemmód során a CPR normál állapotban működik, és az 
összes működtető funkciót ellenőrzi, az [OFF] üzemmód felfüggeszti a 
működést, és leállítja a rendszer kommunikációs buszát. Az [OFF] üzemmódot a 
vezérlő LED-jei jelzik. Általában a felfüggesztett üzemmódot tesztekhez 
használják. 

Lehetséges parancsok és funkciók: 

• Status / Státusz – megmutatja a vezérlő központ információit (típus, 
memória méret, konfigurációs fájlnév, utolsó változtatás stb...) 

• Options / Opciók - CPR tesztek engedélyezése vagy tiltása 



• Initialize / Inicializálás – Az egész CPR memória törlése, óra beállítása 
és újraindítási művelet 

• CPR restart / CPR újraindítás – abban az esetben, ha a CPR nem 
válaszol 

• Read buffer / Memória olvasása – CPR memóriában tárolt események 
kiolvasása 

• Set clock / Óra beállítása – a rendszer órájának összehangolása a 
számítógép órájával 

• Update / Frissítés – konfigurációk küldése a CPR-nek 
• CPR On/Off / CPR BE/Ki – be/ki üzemmód bekapcsolása 

 
Megjegyzés: 

1. Az inicializálás i műveletet általában akkor kell végrehajtani, amikor a 
CPR még nincsen felprogramozva, vagy beállítási hiba történik. CPR hiba 
hálózati feszültség kiesésekor vagy akkumulátor hiba esetén történhet, 
mivel ezek biztosítják a CPR memória tápellátását is. A CPR 
inicializálása manuális úton is lehetséges. 

2. Ha a vezérlő központ hosszú ideig [OFF] üzemmódban van, akkor a 
vezérlők memóriájában tárolt eseményeket ki kell olvasni. Ehhez küldje el 
vezérlők ablakból a Check events buffer in controller / Eseménynapló 
ellenőrzése a vezérlőben parancsot. 



 
 

Low battery test / Alacsony akkumulátor feszültség teszt – A vezérlő 
központ rendszeresen, 10 percenként ellenőrzi az akkumulátor töltöttségi 
szintjét. Ha a feszültség szintje 12.0 V alá esik, akkor  riasztás történik. 

AC test / AC  teszt – Ha a CPR a hálózati feszültség kimaradását észleli, AC 
hiányzik esemény történik. Nem történik riasztás, ha a hálózati feszültség 5 
percen belül visszatér. 

 

Megjegyzés: 

A PRxx1 vezérlő esetén a CPR más funkciókat is ellát – Felügyeli a felhasználói 
belépési jogokat, és a vezérlőktől összegyűjti az eseményeket. 

 



Send network configuration / Hálózati konfiguráció küldése 

Konfigurációs beállítások elküldése az össze alrendszernek (hálózatnak): 

• Kattintson a ikonra az operátor eszközöknél, vagy válassza az 
Edit->Networks / Szerkesztés -> Hálózatokat a főmenüből 

• Válassza ki a megfelelő hálózatot a listából 
• Kattintson az Update / Frissítés gombra 

 

A konfiguráció elküldéséhez a hálózatnak aktívnak kell lennie. A vezérlő 
központnak és az összes vezérlőnek a kiválasztott hálózaton belül elküldi a 
konfigurációs adatokat. 

 

Update configuration of CPR / CPR konfiguráció frissítése 

CPR konfiguráció frissítésének végrehajtásához: 

• Kattintson a ikonra az operátor eszközöknél vagy válassza az 
Edit->Networks  / Szerkesztés -> Hálózatokat a főmenüből 

• Kattintson a CPR gombra 
• A CPR vezérlő ablakban kattintson az Update / Frissítés gombra 

 

Lásd még: 

Configure CPR in network / CPR konfiguráció a Hálózatban 
 

Controllers / Vezérlők 

Általános leírás 
 

A Beléptető rendszer egy autonóm eszköz, amely egyedi belépési pontokat 
ellenőr iz (egy-irányú vagy két-irányú). A két-irányú belépési pont vezérlője egy 
további azonosító terminállal van összekötve. A vezérlő a beléptető és a 
munkaidő nyilvántartó rendszerhez szükséges. Konfigurálható úgy, hogy 
egyszerre ellássa mindkettő, vagy csak az egyik funkciót. A vezérlő NO/NC 
bemenettel, relé és tranzisztor kimenettel rendelkezik. A bemenetek és a 



kimenetek számos előre definiált funkcióra felhasználhatóak. A PRxx2 vezérlő 
4000 felhasználót képes regisztrálni, minden felhasználó azonosítható kártyával,  
PIN kóddal, vagy mindkettővel (kártya+PIN kód). A vezérlő úgy lett kialakítva,  
hogy a mikroprocesszoros memóriájába a Firmware letölthető. A PRxx2 egy 
vagy két külső azonosító terminállal működhet (PRT sorozatú terminál vagy 
Wiegand olvasó). Jellemzően távoli azonosító terminál használatos, ha az ajtót 
mindkét irányból ellenőrizni kell, vagy ha a vezérlőt védett területen kell 
elhelyezni, azért, hogy a vezérlő elektronikus áramköréhez erre fel nem 
hatalmazott személy hozzá ne férhessen. 

A PRxx2 az ajtózárat aktiválhatja belső relé kimeneten keresztül (REL1) vagy 
az XM-2 távoli I/O bővítő relé kimenetén keresztül. Mivel az XM-2 modul 
távoli helyre is telepíthető, ezért az XM-2 expander biztonságos elhelyezése és 
használata tovább növeli a vezérlő biztonsági szintjét. 

A PRxx2 autonóm üzemmódban, vagy CPR vezérlő központtal ellátott, vagy 
anélküli hálózati rendszerben is működhet. A komplex és széleskörű beállításai 
miatt a PRxx2 vezérlő manuálisan nem programozható, kizárólag számítógépről.  
A számítógépről való programozáshoz UT-2 kommunikációs illesztő egység 
szükséges. 

Megjegyzés: 

1. A régi típusú vezérlőknél (PRxx1) a felhasználók maximális száma 1000 
db lehet. Ha 1000-nél több felhasználó konfigurációs adatait küldi el,  
akkor csak a 0-től 999-ig terjedő azonosítószámú felhasználók lesznek 
leprogramozva. 

2. A PRxx2 vezérlő akár 250 belépési csoportot is képes regisztrálni, míg a 
régi típusú (PRxx1) csak 31-et. 

3. Ha nincsen CPR, vagy a CPR [OFF] üzemmódban van, akkor a PRxx2 
vezérlők képesek automatikusan összegyűjteni az eseményeket a nem 
törlődő 32 000-es beépített memóriájukba. 

 

Add controllers / Vezérlők hozzáadása 

Hálózatra csatlakoztatott vezérlők hozzáadása: 

• Kattintson a ikonra az operátor eszközöknél vagy válassza az 
Edit-> Networks / Szerkesztés -> Hálózatokat a főmenüből 

• Kattintson a Controllers / Vezérlők gombra 
• Kattintson az Add / Hozzáadás gombra 



Miután rákattintott a Hozzáadás gombra a program elkezd olyan vezérlőket 
keresni, amelyek a kommunikác iós buszhoz csatlakoznak. A keresési folyamat 
az „End of controllers searching”/„Vezérlők keresésének befejezése” üzenettel 
ér véget, majd megjelenik a talált vezérlők listája: 

 

 

Mindegyik vezérlőnek egyedi azonosító száma van (00..99). Ha a program több, 
ugyanazzal az azonosító számmal rendelkező eszközt talál, hiba üzenet jelenik 
meg. Ezért mindig különböző ID azonosító számot kell beállítani az új vezérlő 
hozzáadása előtt. 

A lehetséges opciók bemutatása: 

Add / Hozzáadás – új vezérlők keresése a kommunikációs buszon 

Delete / Törlés – vezérlő törlése 

Properties / Tulajdonságok – a vezérlő tulajdonságainak megadása 

Change ID / Azonosító (ID) megváltoztatása – a vezérlő egyedi azonosítójának 
kiválasztása 

Update / Frissítés – konfigurációs beállítások elküldése a kiválasztott vezérlőkre 

Diagnostics / Diagnosztikák – kommunikációs tesztek 

Command / Parancs – parancs küldése a kiválasztott vezérlőre 



Controller properties / Vezérlő tulajdonságai 

A vezérlő tulajdonságai tizennyolc fület tartalmaznak: 

• General / Általános – Hardware információk, Vezérlő neve, Hálózat 
• Terminal ID1,ID0 / ID1, ID2 Terminál – Elhelyezkedés, Olvasó típusa, 

Belépési zóna, Alapértelmezett T&A üzemmód, [#] Billentyű opció,  
Azonosítási üzemmód, Magas biztonsági szint 

• Access / Belépés – Ajtózár beállítások (REL1 kimenet), Facility kód,  
Ajtóüzemmód, Kártya + Kártya opció 

• Inputs IN1,IN2,IN3,IN4 / IN1, IN2, IN3, IN4 bemenet – bemenet 
beállítások 

• IO1,IO2 OUTPUT / IO1,IO2 kimenet – kimenet beállítások 
• REL1,REL2 Output / REL1, REL2 kimenet – kimenet beállítások 
• Options / Opciók – T&A üzemmód, Külső modulok, Ajtó Riasztás i 

Opciók, Események tiltása 
• Advanced / Haladó – Anti-passback, Feltételes belépés, RTC teszt, Helyi 

kapcsoló felhasználók listája, Automatikus riasztás, Gyors riasztás 
• Timers / Időzítők –Időzítők beállítása 
• [F1]-[F4] Key / [F1] - [F4] billentyűk - billentyű beállítások 
• Keypad commands / Billentyű parancsok – billentyűzet parancsok 

beállításai 
 

General / Általános 

Itt információkat lehet találni a következőkről: modell, vezérlő azonosító címe, 
firmware verzió, a vezérlő és a hálózat neve. Néha a vezérlő f irmware frissítést 
igényel, pl. : ha a meglévő firmware verzió nem kompatibilis a RACS rendszer 
verziójával. 

 



Lásd még: 

Firmware upgrade folyamat leírása 

 
Terminal ID1,ID0 - ID1, ID0 terminálok 

A Terminal ID1, Terminal ID0 fülnél nevet lehet adni a terminálnak, meg lehet 
határozni az alapértelmezett T&A üzemmódot a munkaidő nyilvántartás  
számára, stb. 

 
 

Location / Elhelyezkedés –A szobát elfoglalható személyek maximális száma 
opció miatt az elhelyezkedésnek fontos szerepe van. Hogy az elhelyezkedés az 
Belépés, vagy Kilépés, az szintén fontos a vezérlő Feltételes belépés opciója 
miatt. Ebben az esetben ugyanis, az első jogosult személy azonosíthatja magát a 
Belépési olvasón. Az olvasó elhelyezkedése nincs hatással a T&A üzemmódra. 



Type / Típus – 12 lehetséges opció közül lehet választani. Ha távoli olvasó nincs 
csatlakoztatva, akkor az ID0 fülnél válassza azt, hogy None / Egyik sem opciót. 
Ennél a funkciónál letiltható a beépített olvasó (vezérlőbe épített) is. 

• PRT soros olvasó (PIN kód/kártya átvitel) 
• PRT soros olvasó (felhasználói azonosítót átvitel) 
• Wiegand olvasó – PIN (HEX) / Kártya 
• Wiegand olvasó – PIN (BIN) / Kártya 
• Wiegand olvasó – csak PIN 
• Wiegand olvasó – Felhasználói azonosító (HEX) 
• Wiegand olvasó - Felhasználói azonosító (BIN) 
• Magstripe PIN olvasó 
• Magstripe Kártyaolvasó 
• Magstripe felhasználói azonosító olvasó 
• Egyik sem 
 

A Wiegand olvasó, a standard PRT terminállal ellentétben, a Clock / Data 
vonalakkal van összekötve. Amikor a vezérlő a Wiegand Felhasználói azonosító 
olvasó működtetésére van konfigurálva, akkor az átvitt számjegyeket úgy 
értelmezi, mint a felhasználó azonosító számát, mely már kész az azonosításra, 
amikor a vezérlőn a Wiegand PIN olvasó van beállítva, akkor az átvitt 
számjegyeket úgy értelmezi, mint a PIN számokat, amikor Wiegand Kártya 
olvasó van beállítva, akkor az átvitt számjegyeket úgy értelmezi, mint 
kártyaszámokat. A Wiegand felhasználói azonosító üzemmódot jellemzően 
biometrikus olvasók használják, amelyek nem visznek át se PIN se 
kártyaszámokat, csak azonosító számokat, amelyek elegendőek a sikeres  
azonosításra. Ha a vezérlő Wiegand típusú olvasóra van konfigurálva, akkor más 
bővítő modulokat (XM-2, XM-8 vagy PSAM1), vagy standard PRT olvasókat 
nem lehet csatlakoztatni a vezérlő Clock / Data vonalaihoz. Alapértelmezett 
esetben a vezérlő a Clock / Data vonalakhoz csatlakoztatott Wiegand olvasót 
BELÉPÉSI terminálként kezeli. 

Access zona / Belépési zóna – válasszon belépési zónát a terminál számára. Az 
ID1 és ID2 terminálok különböző belépési zónákhoz is rendelhetőek. 

Default T&A üzemmód / Alapértelmezett T&A üzemmód – válasszon 
üzemmódot a listából, amely tartalmazza a rendszerben meghatározott összes 
T&A üzemmódot. Válasszon szabadon T&A üzemmódot. Nem kell a Kilépés i 
olvasón meghatározni a Kilépési T&A üzemmódot, mivel az olvasó 
elhelyezkedése nincs hatással a T&A üzemmódra. Négy előre definiált T&A 
üzemmód létezik: a Belépés, a Kilépés, a Hivatalos kilépés (ODE), és a Nem 
T&A (a T&A mellőzi). 



Ezen kívül a program lehetővé teszi saját T&A üzemmódok létrehozását az 
egyedi igényeknek megfelelően (Tools-> T&A üzemmódok / Eszközök -> T&A 
üzemmódok). 

[#]Key options / [#] Billentyű opció – a vezérlő kezelőjén a [#] billentyű 
megnyomása Ajtó csengőként, vagy Ajtónyitó gombként működik, a beállított 
időzítőnek megfelelően. Ha az Always / Mindig ütemező van beállítva, akkor a 
[#] Billentyű Ajtónyitóként fog funkcionálni, ha a Never / Soha lett beállítva,  
akkor a [#] Billentyű Ajtócsengő gombként működik. Ha különböző típusú 
időzítők lettek kiválasztva, akkor az előre meghatározott időperiódusokban a [#] 
Billentyű Ajtónyitóként, és a meghatározott időperiódusok között Ajtócsengőkét 
fog funkcionálni. 

Identification mode / Azonosítás üzemmód – válassza ki a vezérlőn a Default 
Identification Mode / Alapértelmezett azonosítás üzemmódot, amely minden 
felhasználó típus számára normál azonosítási üzemmódot engedélyez. (Master, 
Kapcsoló, és Normál). Lehetséges opciók: Kártya vagy PIN, Kártya és PIN, 
csak Kártya, csak PIN. A meghatározott időzítő szerint az azonosítás üzemmód 
automatikusan válthat az azonosítás üzemmódok között. Beállíthatja a saját 
azonosítás üzemmód időzítőjét (Azonosítás üzemmód időzítők). 

High security / Magas biztonsági szint – Ha ez a üzemmód aktív, akkor a 
felhasználóknak két lépésből álló azonosítási folyamatot kell végrehajtaniuk,  
egy standard azonosítást, (Kártya/PIN vagy Kártya+PIN az éppen érvényes  
azonosítási üzemmódtól függően) és egy kiegészítő azonosítást a Magas 
biztonsági szintű olvasón.  A magas biztonsági szintű olvasót ugyanarra a 
Clock/Data vonalra is lehet csatlakoztatni, amelyik a Belépés/Kilépés  
terminálokkal és/vagy a bővítő modulokkal van összekötve. A vezérlő néhány 
Magas biztonsági szintű olvasót támogat, pl.: a Wiegand Kártya/Pin és a 
Wiegand felhasználói azonosító. A Wiegand Kártya/PIN a beléptetett PIN kódot 
vagy Kártya kódot küldi el, a Wiegand felhasználói azonosító azt az azonosító 
számot küldi el, amely a felhasználót azonosítja. A Magas biztonsági szint opció 
külön aktiválható az ajtó mindkét oldalára és időzítőkkel vezérelhető. Általában,  
a Magas biztonsági szint opciót olyan ajtóknál használják, amelyeket további 
azonosítással kell védeni (pl biometrikus azonosítás). 

Lásd még: 

Szószedet 
T&A üzemmódok 

 



Beléptetés 

 

Door lock settings (REL1 output) / Ajtózár beállítások (REL1 kimenet) – az 
ajtó zár nyitható: 

• amikor a jogosult felhasználó megadja az azonosítóját 

• távoli számítógépes paranccsal 

• A vezérlő bemenetre kötött Ajtónyitó gombbal vagy a hozzá rendelt [#]  
Billenyűvel 

A Lock activation time / Zár aktiválási időben adható meg, hogy az ajtózár  
mennyi időre aktiválódjon. A zár aktiválási idő 1-től 99 percig / másodpercig 
programozható vagy nem meghatározott ideig, ebben az esetben a Bistabil 
üzemmód opciót kell kiválasztania.  Ekkor minden ajtó zár aktiválása esetén az 
ajtózár ellentétes állapotba kerül (aktívból- deaktívba, vagy fordítva). Auto-
relock / Automata visszazárás beállításakor a zár addig lesz aktív, amíg a 
vezérlő bemenetére kötött ajtó nyitás érzékelő jelzi, hogy az ajtó nyitva van, de 
nem lehet tovább nyitva, mint ahogy a Zár aktiválási időnél be lett állítva. A zár  



működés hatástalanítható, ha a vezérlő Élesített üzemmódban van, ehhez az 
Access disabled when controller armed / Belépés letiltva, ha a vezérlő élesített 
opciót engedélyezze. Ez általában akkor használatos, ha az egyik vezérlő 
kimenet élesített/hatástalanított riasztási zónára vagy csak betörés érzékelőre van 
beállítva. Ebben az esetben a vezérlő Armed / Élesített üzemmódba 
kapcsolásakor élesíteni fogja a riasztó rendszert vagy riasztó zónát, és  
automatikusan letiltja a belépést az összes felhasználó számára a belépés i 
beállítások figyelembe vétele nélkül. 

Facility Code / Létesítmény kód – Bizonyos esetekben a beléptető rendszernél 
használt összes kártyának van egy közös kód része, ezt a részt Facility kódnak 
hívják. A Facility kód 8 adat bitből áll, a bitek 10-es számrendszerbe történő 
átkonvertálása 0-tól 255-ig ter jedő számot ad eredményül. Ha az opció aktív, 
akkor a belépés csak azoknak a kártyáknak engedélyezett, amelyek ugyanazzal a 
Facility kóddal rendelkeznek. Ha az opc ió aktív, akkor a vezérlő leellenőrzi,  
hogy az olvasott kártya rendelkezik-e a megadott kóddal, és ha igen a kártyát 
elfogadja a teljes kód ellenőrzése nélkül. Ez sok felhasználós rendszer esetén 
(pl. egyetem/főiskola területe) nagyon hasznos, ha minden olyan kártyát be kell 
léptetni, amelynek azonos a Facility kódja. Ehhez az opcióhoz időzítős és 
kimeneti vezérlést is lehet rendelni. 

A kód manuális úton és a kártyából való kiolvasással is megadható. 

A kód beolvasása: 

• Kattintson a   gombra 
• Válassza ki azt a vezérlőt vagy az olvasót, amin a kártya kódot le szeretné 

olvastatni 
• Közelítse a kártyát a vezérlőhöz/ olvasóhoz 

 

Door mode / Ajtó üzemmód – Ajtó üzemmód határozza meg, hogy a vezérlő 
hogyan fogja ellátni árammal, vagy áramtalanítani az ajtózárat. Alapértelmezett 
esetben az ajtó zár Normál üzemmódban van, de távoli paranccsal vagy időzítő 
segítségével egy másik ajtó üzemmódba átváltható. Az időzítővel való váltás  
engedélyezéséhez, jelölje be a Door Mode controlled by schedule / Időzítő által 
vezérelt Ajtó Üzemmódot és válasszon ki egy előzőleg beállított időzítőt a 
listából. 

Az ajtó zár a következő néhány üzemmódba állítható: 

• Normal / Normál – Az ajtó zár aktiválódik, miután a vezérlő engedélyt ad 
a belépésre 

• Unlocked / Nyitott – Az ajtó zár folyamatosan árammal van ellátva, az 
ajtót bárki kinyithatja 



• Conditional Unlocked / Feltételesen nyitott – Alapvetően az ajtó zárt 
állapotban van, de miután az első arra felhatalmazott személy használja az 
azonosítóját, az ajtó kinyílik és ebben az állapotban marad, egy újabb ajtó 
üzemmód megadásáig. 

• Locked / Zárt – az ajtó zár nem aktiválódik, nem számít, hogy a 
felhasználónak van belépési engedélye vagy nincs, minden ajtónyitás i 
kísérlet hatástalan lesz. 

 

Card + Card (Two users) / Kártya + kártya (két felhasználó) –Ahhoz, hogy 
a vezérlő az ellenőrzött ajtón engedélyezze a belépést, két jogosult személy kell 
használja az azonosítóját. 

Ez az üzemmód [Kártya + Kártya] időzítővel vezérelhető, a Soha időzítő 
kiválasztása le fogja tiltani ezt a üzemmódot teljesen, a Mindig időzítő pedig 
folyamatosan aktivizálni fogja. Ha a [Kártya + Kártya] opcióval együtt a [Kártya 
+ PIN] üzemmód is aktív, akkor mindkét felhasználónak le kell olvastatni a 
kártyáját, és meg kell adnia a PIN kódját, különben nem tudnak belépni. 

Lásd még: 

Általános célú időzítők 
 

Inputs IN1,IN2,IN3,IN4 / IN1, IN2, IN3, IN4 Bemenetek 

A beléptető vezérlőnek négy bemeneti vonala van. Minden vezérlő bementetnek 
(IN1, IN2, IN3, és IN4) egyedi elektromos kiépítése van. Mindegyik bemenet 
NO/NC típusú, 5,6 k lezáró ellenállást igényel, és a pozitívhoz van kötve. A 
beállítás i folyamat alatt a telepítő minden bemenetet szabadon konfigurálhat 
NO, vagy NC típusúra. Az NO bement akkor aktiválódik, ha összekötik azt a 
mínusszal. Az NC bemenet normál állapotban a mínusszal össze van kötve, és 
akkor aktiválódik, ha az összekötés megszakad. A vezérlő figyelmen kívül 
hagyja az aktiváló impulzust, ha az 200ms-nál rövidebb ideig tart és elfogadja 
azt, ha az 500ms-nál hosszabb ideig tart. 200 ms és 500 ms közötti impulzusok 
esetén a működés nem garantált. Mindegyik vezérlő bemenet más-más funkcióra 
programozható és az időzítő által vezérelhető. 

 



 

 

Bemeneti funkciók fajtái: 

• No.0: Input OFF / Bemenet ki (nem használt) – Letiltja a bemenetet, a 
funkció hatására a bemenet ideiglenesen letiltható a bemenet fizikai 
lekötése nélkül. 

• No.1: Door contact / Nyitásérzékelő – A bemenet az ajtó nyitását jelzi.   
A bemenet aktiválása [Door opened] / [Ajtó nyitva] eseményt, a bemenet 
deaktiválása pedig [Door closed]/ [Ajtó zárva] eseményt hoz létre. 

• No.2: Exit button / Kilépés gomb – Erre a bemenetre kell az ajtónyitó 
gombot csatlakoztatni, amely kinyitja az ajtót az azonosító megadása 
nélkül. A bemenet aktív állapota aktiválni fogja az ajtózárat ugyanarra az 
időtartamra, mint amelyre a standard [Belépés engedélyezve] esemény is. 
A bemenet aktiválása / deaktiválása [Exit button ON] / [Kilépés gomb 
BE] és [Exit button OFF] / [Kilépés gomb KI] eseményt hoz létre. 
 

• No.3: Arm / Disarm Steady Switch / Élesített/Hatástalanított állapot 
kapcsolása – Olyan gomb, kapcsoló vagy kimeneti vonal használatához 
szükséges, amely vezérli a vezérlő aktuális [Élesített/Hatástalanított]  
állapotát. A bemenet aktiválása a vezérlőt [Hatástalanított] üzemmódba 
kényszeríti, és egészen addig, amíg a bemenetnek megváltozik az állapota 
a vezérlő [Hatástalanított] üzemmódban marad. A vezérlőn kizárólag egy 
bemenet konfigurálható erre a funkcióra. A funkció kiválasztásakor az 
[Élesített/Hatástalanított] üzemmód összes többi vezérlése le lesz tiltva.   
 



• No.5: AC Lost Input / AC feszültség kiesés bemenet– Ezt a bemenetet 
egy olyan kimenethez, vagy kontaktushoz kell kötni, amely az AC 
feszültség kiesését vagy a tápegység elvesztését jelzi. Néhány tápegység 
típus rendelkezik ilyen kimeneti vonallal (pl. Roger PS20N). Ha a 
bemeneti vonalnak megváltozik az állapota, akkor a vezérlő [AC lost 
alarm ON] / [AC kiesés riasztás] eseményt, ha a vonal visszatér normál 
állapotba, akkor a vezérlő [AC lost alarm OFF]/[AC kiesés visszaállás]  
eseményt generál. 

• No. 6: Low battery input / Alacsony akkumulátor feszültség bemenet 
– Ezt a bemenetet egy olyan kimenethez vagy kontaktushoz kell kötni,  
amely a tartalék akkumulátor alacsony feszültségét jelzi. Néhány 
tápegység típus rendelkezik ilyen kimeneti vonallal (pl. Roger PS20N). 
Ha a bemeneti vonalnak megváltozik az állapota, akkor a vezérlő [Low  
battery alarm input ON] / [Alacsony akkufeszültség riasztás] eseményt, ha 
a vonal visszatér normál állapotba, akkor a vezérlő [Low battery alarm 
input ON]/[Alacsony akkufeszültség visszaállás] eseményt generál. 

• No. 7: Bell button input / Csengő gomb bemenet - Ezt a bemenetet egy 
olyan gombhoz kell csatlakoztatni, amely jelzi, ha valaki be akar lépni az 
épületbe. Ha a bemeneti vonalnak megváltozik az állapota, akkor a 
vezérlő [BELL button ON] / [Csengő gomb BE] eseményt generál, és  
opcionálisan aktiválja a [Bell output] / [Csengő kimenet]- nek 
felprogramozott vezérlő kimenetet. Ha visszatér normál állapotba, akkor a 
vezérlő egy [BELL button OFF] / [Csengő gomb KI] eseményt hoz létre 
és törli a [Csengő kimenet] vonalat. 

• No.8: Tamper loop input / Szabotázs hurok bemenet – Ezt a bemenetet 
a szabotázs kontaktushoz kell csatlakoztatni, amely jelzi, ha egy arra nem 
felhatalmazott személy próbálja kinyitni a vezérlő/terminál dobozát. Ha a 
bemeneti vonalnak megváltozik az állapota, akkor a vezérlő [Tamper loop 
ON] / [Szabotázs vonal aktív] eseményt, ha a vonal visszatér normál 
állapotába, akkor a vezérlő [Szabotázs vonal visszatér] eseményt generál. 

• No. 9: Intruder Detector Input / Betörés érzékelő bemenet – Ezt a 
bemenetet valamilyen betörés érzékelőhöz (pl. PIR) kell csatlakoztatni,  
amely jelzi a betörő jelenlétét az épületben. Ha a bemeneti vonalnak 
megváltozik az állapota, akkor a vezérlő [Intruder detector ON] / [Betörés 
érzékelő aktív] eseményt, ha a vonal visszatér normál állapotba, akkor a 
vezérlő [Intruder detector OFF] / [Betörés érzékelő visszatér] eseményt 
generál. A betörés érzékelő vonal kiiktatható [ON] üzemmódban a 
[Disable Intruder detector when controller in ON mode] / [Betörés 
érzékelő kiiktatása, ha a vezérlő ON üzemmódban van] opció 
kiválasztásával. 



• No. 11: Access Disable Input / Belépés tiltva bemenet – Ezt a 
bemenetet olyan kapcsolóhoz vagy kimenethez kell csatlakoztatni, amely 
aktiváláskor, letiltja a belépést az ellenőrzött ajtón. A bemeneti vonal 
aktiválása / deaktiválása [Access disable input ON] / [Belépés tiltva 
bemenet aktív] és [Access disable input OFF]/[Belépés tiltva bemenet 
visszaállt] eseményt generál. 

• No. 56: Selects Predefinied T&A Mode (steady change)- Előre  
beállított T&A üzemmód kiválasztása (állandó váltás)– Ezt a 
bemenetet egy olyan gombhoz kell csatlakoztatni, amelynek megnyomása 
a vezérlőt meghatározott T&A üzemmódba kapcsolja. A T&A üzemmód 
váltását minden bemeneti vonalra egyénileg meg lehet adni. Az új T&A 
üzemmód egészen addig aktív lesz, amíg a következő parancs meg nem 
változtatja a vezérlő aktuális T&A üzemmódját 

• No. 57: Selects Predefinied T&A Mode (momentary change) Előre  
beállított T&A üzemmód kiválasztása (pillanatnyi váltás)- Ezt a 
bemenetet egy olyan gombhoz kell csatlakoztatni, amelynek megnyomása 
a vezérlőt meghatározott T&A üzemmódba állítja be. A T&A üzemmód 
váltását minden bemeneti vonalra egyénileg meg lehet adni. Az új T&A 
üzemmód a legközelebbi felhasználói azonosításig aktív, de amennyiben 
8 másodpercen belül nem történik azonosítás, a vezérlő visszatér az 
előzőleg kiválasztott T&A üzemmódba. 

• No. 60: Reset APB register / APB regiszter törlése – Ezt a bemenetet 
egy olyan gombhoz kell csatlakoztatni, amelynek megnyomása törli a 
vezérlő APB regiszterét. Ha a bemenet aktiválódik, akkor a vezérlő belső 
APB regisztere kezdő értékre áll (törlődik) és ez [APB Reset] / [AP B 
törlés] eseményt generál. 

• No. 62: Set XM-8 outputs OFF / XM-8 kimenetek lekapcsolása– Ezt a 
bemenetet egy olyan kimenethez vagy kontaktushoz kell csatlakoztatni,  
amely aktiválása esetén törli az összes kimenetet az XM-8 liftvezérlő 
modulon. 

• No. 63: Set XM-8 outputs ON / XM-8 kimenetek bekapcsolása - Ezt a 
bemenetet egy olyan kimenethez vagy kontaktushoz kell csatlakoztatni,  
amely aktiválása esetén bekapcsolja az összes kimenetet az XM-8 
liftvezérlő modulon. 

 

A felsorolt, előre definiált funkciókon kívül a felhasználó által meghatározott 
funkcióra is konfigurálhatóak a bemeneti vonalak. A szoftver használatával új 
bemeneti funkciókat lehet beállítani. A bementi vonal meghatározása, a funkció 



nevéből és a kódjából áll. A funkció neve a bemenet céljának 
megkülönböztetésére szolgál pl. [Őrjárat Gomb], [Riasztás gomb] [Szervizigény 
Gomb]. Ha a bemenet aktiválódik, akkor a rendszer regisztrálja az eseményt, a 
regisztrálás a funkció névből és BE vagy KI állapotából áll, amely megmutatja,  
hogy a bemeneti vonal aktiválva vagy deaktiválva volt. Mindegyik bemenet 
aktiválása időzítőről vezérelhető. 

IO1, IO2 Output / IO1,IO2 Kimenet 

IO1, IO2 Kimeneti vonalak 

Mindkét kimeneti vonal egy-egy nyitott N-MOS tranzisztoros kimenet. Mindkét 
kimenet korlátlan ideig terhelhető 1 A DC áramerősséggel. Normál (nem 
aktivált) állapotban mindkét kimenet magas impedancia állapotban van, miután 
aktiválódott alacsony ellenállási státuszba kerül, melynek következtében a 
kimenetre a mínusz kerül. Mindkét kimenet elektronikusan védett a túl magas  
feszültségtől és áramerősségtől. Mindkét tranzisztoros kimenet különböző 
funkciókra programozható, és egyéni időzítők által vezérelhető. 

 

A kimeneti vonalak a következőképpen programozhatóak: 

• No.0: Disarmed Mode / Hatástalanított üzemmód – a kimenet akkor 
aktiválódik, ha a vezérlő [HATÁSTALANÍTOTT] üzemmódba kapcsol, 
és aktív marad mindaddig, amíg ebben a üzemmódban marad 

• No. 256: Door Alarm / Ajtóriasztás – Ha a „Time for door closing” / 
„Ajtózárási idő”-nél beállított időnél hosszabb ideig marad az ajtó nyitva,  
akkor két másodpercenként duplát pulzál a kimenet 

• No. 8: PC Command controlled / Vezérelt PC parancs – a kimenet a 
PC-ről küldött paranccsal aktiválható/deaktiválható 

• No. 9: Access granted / Belépés engedélyezve – a kimenet akkor 
aktiválódik, ha a vezérlő engedélyezi a belépést, és aktív marad, addig, 



amíg az ajtónyitás érzékelő azt nem jelzi, hogy az ajtó be lett zárva, vagy 
a zár aktiválási idő le nem járt. 

• No. 10: Door Open / Ajtó nyitva – a kimenet akkor aktiválódik, ha a 
vezérlő érzékeli, hogy az ajtó nyitva van, és egészen addig aktív marad,  
amíg az ajtó nyitva van. 

• No. 11: Access Denied / Belépés elutasítva – miután a vezérlő 
elutasította a belépést, a kimenet 2 másodpercig aktív lesz. 

• No. 12: Schedule Controlled / Vezérelt ütemező – a kiválasztott 
ütemezőnek megfelelően aktivált/deaktivált lesz a kimenet, ekkor a 
kimenet állapotát más módszerrel megváltoztatni nem lehet. 

• No. 13: Schedule or PC Command Controlled / Vezérelt ütemező 
vagy PC parancs - a kiválasztott ütemezőtől vagy egy PC-ről érkező 
parancstól függően aktivált/deaktivált lesz a kimenet, mindkét vezérlői 
üzemmód ugyanazzal a prioritással rendelkezik. 

• No. 14: Entry-Exit Status / Belépés-Kilépés státusz – Az ID0 
terminálon történő s ikeres azonosítást követően a kimenet aktiválódik, és  
ebben az állapotban marad az ID1 terminálon történő sikeres azonosításig. 
Hasznos lehet ez az opció, ha a vezérlő olyan típusú kapuval dolgozik,  
ahol az órajárással megegyező és az órajárással ellentétes irányú forgatást 
is be kell állítani, attól függően, hogy melyik terminálon történt az 
azonosítás. 

• No. 15: Door Bell / Ajtócsengő – a kimenetet egy külső ajtócsengőhöz 
kell csatlakoztatni. 

• No. 16: Room Occupied / Foglalt szoba – a kimenet akkor aktiválódik,  
ha valaki elfoglalj a szobát, és akkor deaktiválódik, ha nincsen senki a 
szobában. 

• No. 17: Limit of Users Reached / A felhasználók számának elérése – a 
kimenet akkor aktiválódik, ha egy szoba foglaltságához szükséges határt 
elér i a felhasználók száma. 

• No. 18: Normal Door Mode / Normál ajtó üzemmód – a kimenet akkor 
aktiválódik, ha a vezérlő Normál Ajtó Üzemmódban van. 

• No. 19: Unlocked Door Mode / Nyitott ajtó üzemmód - a kimenet akkor 
aktiválódik, ha a vezérlő Nyitott ajtó üzemmódban van. 



• No. 20: Conditional Unlocked Door Mode / Feltételesen nyitott ajtó 
üzemmód - a kimenet akkor aktiválódik, ha a vezérlő Feltételesen nyitott 
ajtó üzemmódban van. 

• No. 21: Locked Door Mode / Zárt ajtó üzemmód - a kimenet akkor 
aktiválódik, ha a vezérlő Zárt ajtó üzemmódban van. 

• No. 22: Postponed Auto-arming Delay in Progress / Elhalasztott 
automatikus riasztás késleltetése folyamatban – ha a vezérlőnek 
elküldik az automatikus riasztás késleltetés parancsot, akkor a kimenet 
aktiválódik. 

• No. 23: External buzzer / Külső zümmer – a kimenet a vezérlő belső 
zümmerével párhuzamosan aktiválódik és deaktiválódik. Ezt a funkciót 
akkor használják, ha külső zümmer szükséges. Pl. néhány Wiegand típusú 
olvasó csatlakoztatásánál. 

• No. 24: Terminal Reset / Terminál törlése 

• No. 25: Pulse on disarming / Hatástalanított állapotban pulzálás 

• No. 26: Pulse on arming / Élesített állapotban pulzálás 

• No. 27: Arm Request / Riasztás lekérés 

• No. 28: Forced Entry / Erőszakos belépés – a kimenet  0,5 mp-ig pulzál,  
0,5 mp-ig nyugalomban van a vezérlő használata nélküli erőszakos 
ajtónyitás után. 

• No. 29: Prealarm / Előriasztás – egyet pulzál minden második 
másodpercben, ha 1 percen belül egymás után három ismeretlen azonosító 
tesz belépési kísérletet. 

• No. 30: Door Ajar / Ajtó félig nyitva 

• No. 31: Door Chime / Ajtó csengő 

• No. 32: APB violation / APB sértés – Az Anti-passback megsértése 
esemény után a kimenet 2 másodpercig aktív lesz. 

• No. 64: Light / Világítás 

• No. 65: Tamper Alarm / Tamper riasztás 

• No. 66: AUX1 

• No. 67: AUX2 



• No. 68: Intruder Alarm / Betörésriasztás 

• No. 84: Card or PIN mode for terminal ID0 / Kártya vagy PIN 
üzemmód az ID0 terminálon– a kimenet akkor aktiválódik, ha kártya 
vagy PIN üzemmód lett az ID0 terminálon beállítva. 

• No. 85: Card only for terminal ID0 / Csak kártya az ID0 terminálon– 
a kimenet akkor aktiválódik, ha csak kártya üzemmód lett az ID0 
terminálon beállítva. 

• No. 86: PIN only for terminal ID0 / Csak PIN az ID0 terminálon– A 
kimenet akkor aktiválódik, ha csak PIN  üzemmód lett az ID0 terminálon 
beállítva. 

• No. 87: Card and PIN mode for terminal ID0 / Kártya és PIN 
üzemmód az ID0 terminálon - A kimenet akkor aktiválódik, ha kártya és 
PIN üzemmód lett az ID0 terminálon beállítva. 

• No. 88: Card or PIN mode for terminal ID1 / Kártya vagy PIN 
üzemmód az ID1 terminálon– a kimenet akkor aktiválódik, ha kártya 
vagy PIN üzemmód lett az ID1 terminálon beállítva. 

• No. 89: Card only for terminal ID1 / Csak kártya az ID1 terminálon– 
a kimenet akkor aktiválódik, ha csak kártya üzemmód lett az ID1 
terminálon beállítva. 

• No. 90: PIN only for terminal ID1 / Csak PIN az ID1 terminálon– A 
kimenet akkor aktiválódik, ha csak PIN  üzemmód lett az ID1 terminálon 
beállítva. 

• No. 91: Card and PIN mode for terminal ID1 / Kártya és PIN 
üzemmód az ID1 terminálon - A kimenet akkor aktiválódik, ha kártya és 
PIN üzemmód lett az ID1 terminálon beállítva. 

REL1,REL 2 Output / REL1, REL2 Kimenet 

A vezérlő két tranzisztoros kimenettel (IO1, IO2), és két relé kimenettel (REL1 
és REL2) rendelkezik. A REL1 relé kimenetet az ajtózár vezérlésére használják,  
a REL2, IO1 és IO2 funkcióit a vezérlő beállításánál lehet megadni. 

Relé kimenet (REL1) 

A relé kimenetet az elektronikus ajtózár vezérlésére használják, ez lehet normál 
nyitott és normál zárt kontaktus, amely 24V DC-n, vagy AC-n 1.5 A-rel 
terhelhető. 
Mindkét relé kontaktus (MOV) túlfeszültség védelemmel lett ellátva, amely az 
elektromos zárak kapcsolása során fellépő induktív terhelésekkel szemben 



megvédi az elektronikus áramköröket, és így hosszú élettartamot biztosít a 
reléknek. 

A relé kimenet pillanatnyi, vagy bistabil üzemmódra programozható. Ha a 
kimenet pillanatnyi üzemmódra lett konfigurálva, akkor meghatározott időre 
aktiválódik (1 másodperctől 255 percig), majd ezután visszatér normál 
állapotba. Ha a kimenet bistabil üzemmódra lett konfigurálva, akkor az 
aktiválása a relé kimenetet az aktuális állapot ellenkezőre változtatja. 

 

 

Relé kimenet (REL2) 

Ez a kimenet különböző funkciókra konfigurálható, és lehet normál nyitott vagy 
normál zárt kontaktus, amely 24V DC-n, vagy AC-n 1.5 A-rel terhelhető.  
Mindkét relé kontaktus (MOV) túlfeszültség védelemmel lett ellátva, amely az 
elektromos zárak kapcsolása során fellépő induktív terhelésekkel szemben 
megvédi az elektronikus áramköröket, és így hosszú élettartamot biztosít a 
reléknek. 

 

 

Opciók 

A lehetséges opciók leírása: 

• Enable Arm / Disarm Schedule - Élesített/Hatástalanított ütemező 
engedélyezése – Ha ez be van jelölve, akkor az időzítőtől függően 
automatikusan átkapcsol Élesített vagy Hatástalanított üzemmódba. Az 
ütemező meghatározásához nyissa meg a Edit->Arm/Disarm Schedule / 
Szerkesztés -> Élesített/Hatástalanított ütemező menüpontot. 

• Ignore DURESS Codes / Kényszerített kódok figyelmen kívül hagyása 
- Ha ez engedélyezett, akkor kényszerített kód megadásakor a vezérlő 
nem generál riasztást. 



• Timed lock-out after three wrong identifiers / Kizárás három rossz 
azonosító után – Három egymást követő alkalommal ismeretlen 
azonosító bevitele esetén a vezérlő három percre kizárja az új azonosítást. 
Ez idő alatt se a vezérlőn, se a terminálon nem lehetséges azonosítás. 

• Disable Intruder detector input when controller disarmed / Letiltott 
betörés detektor bemenet a vezérlő hatástalanított állapotában– a 
bemenet nem aktív, ha a vezérlő hatástalanított üzemmódban van. 

• If access denied SWITCHER can’t rearm the controller / A belépés  
elutasításánál a kulcs nem tudja újra élesíteni a vezérlőt – Csak 
engedélyezett beléptetés esetén lehetséges az élesített/hatástalanított 
üzemmód átkapcsolása. 

 

DURESS CODES / KÉNYSZERÍTETT KÓDOK – Kényszerített belépés – 
Amikor a felhasználó olyan PIN kódot ad meg, amely „eggyel” eltér az 
eredetitől (plusz vagy mínusz irányba), akkor a vezérlő azt kényszerített 
belépésként értelmezi. Ha kényszerített belépés történik, akkor az 



[DURESS]/[KÉNYSZERÍTÉS] eseményt generál és FORCED ENTRY / 
ERŐSZAKOS BELÉPÉS riasztás történik. 

 

Példa: 

Ha az eredeti kód [4569], akkor [4568] [#] vagy [4560] [#] megadása 
kényszerített belépést eredményez. 

Megjegyzés: A kényszerített belépés megfelelő használatához, az egyes 
felhasználók PIN kódjainak utolsó számjegyének legalább +/- [2] –vel el kell 
térnie egymástól. 

A kényszerített jelzés a PR Master szoftverrel deaktiválható. 

Term ID0 has the same T&A mode as term ID1 / Az ID=0 terminál 
ugyanazzal a T&A üzemmóddal rendelkezzen, mint ai ID1 terminál -  Ha az 
opció aktív, akkor az ID=0 terminálon regisztrált eseményeknek ugyanaz lesz a 
T&A üzemmódja, mint az ID=1 terminálon regisztrált eseményeknek (nem 
számít, hogy az ID=1 vagy ID=0 terminál regisztrálja az eseményt, ugyanabban 
a T&A üzemmódban lesz , amelyben az ID=1 terminál van). Ez abban az 
esetben lehet hasznos opció, ha a vezérlő olyan rendszerbe van integrálva, ami 
más kártya típust használ (pl. HID, Mifare). Ebben a konfigurációban a T&A 
üzemmód megváltoztatható a vezérlőn (billentyűzet, bemeneti vonal vagy 
időzítő használatával), de az azonosítás egy másik, a  Clock & Data vonalhoz 
csatlakoztatott Wiegand olvasó egységen keresztül történik. 

Külső modulok 

• XM-8 modulok  A PRxx2 sorozatú vezérlő összeköthető egy vagy két 
távoli XM-8 I/O modullal, amelyek az eszközhöz a Clock & Data 
vonalon keresztül csatlakozhatnak. A PRxx2 az XM-8 felvonó vezérlő 
egységgel is összeköthető. Az első XM-8 modul (cím: ID=8) vezérli a 
belépést az első 8 emeletre, a második (cím: ID=9) modul vezérli a 
belépést a második 8 emeletre (9-16). Sikeres azonosítás esetén, a vezérlő 
meghatározza, hogy melyik emeletekre jogosult a felhasználó, majd 
aktiválja a megadott XM-8 reléket. A relék aktivált állapotban maradnak 
addig amíg, nem aktiválódik az Clears all outputs on XM-8 elevator 
control module(s) / Összes kimenet törlése az XM-8 felvonó vezérlő 
modulokon bemenet, vagy új kimenet nem aktiválódik a következő 
azonosítás miatt. Az XM-8 modulokkal kapcsolatos műveletek a 
következő opción keresztül aktiválhatóak: Enable XM-8 elevator control 
module(s) / XM-8 felvonó vezérlő modul(ok) engedélyezése. Az XM-8 
kimenetei a következő programozott bemeneti vonalon keresztül 



aktiválhatóak: Sets all outputs on XM-8 elevator control module(s) / Az 
XM-8 felvonó vezérlő modul(ok  összes kimenetének aktiválása. 

 
• XM-2 modul- A vezérlőhöz a Clock&Data vonalon keresztül egy külső 

XM-2 I/O modul (cím=5) csatlakoztatható. Az XM-2 két kimeneti relével 
(REL1 és REL2), és két NO/NC bemenettel (IN1 és IN2) rendelkezik. Az 
XM-2 REL1 kimenete a vezérlő REL1 kimenetével párhuzamosan 
aktiválódik és deaktiválódik, az XM-2 második kimenete (REL2) a 
vezérlő IO2 kimenetével párhuzamosan aktiválódik és deaktiválódik. Az 
XM-2 bemenetei normál esetben le vannak tiltva, de ha a vezérlői 
beállítások alatt engedélyezi őket, akkor a vezérlő alaplapján található 
IN1/IN2 bemenetek helyett is használhatóak. Kiválasztható, hogy a helyi 
vagy a távoli bemeneteket kezelje a vezérlő. Az XM-2 modult jellemzően 
a PR302/PR302LCD vezérlők használják, amelyek normál esetben a 
belső reléjükön keresztül aktiválják az ajtózárat, ehhez a reléhez 
jogosulatlan személyek is könnyen hozzáférhetnek. Ezért XM-2 
használatakor, az ajtózár nem csak a belső relén keresztül aktiválható,  
hanem egy védett térben elhelyezett távoli relé kimeneten keresztül is,ez 
tovább növeli a rendszer biztonságát. Az XM-2 modul opció a 
következőképpen aktiválható: Enable XM-2 remote I/O expander modul 
/ XM-2 távoli I/O bővítő modul engedélyezése 

 
Az XM-2-nek két további opciója létezik: 

1. Ignore IN1 on controller, enable IN1 on XM-2 / IN1 tiltása a 
vezérlőn, IN1 engedélyezése az XM-2-n – a vezérlő a távoli (az 
XM-2) IN1 bemenetet fogja használni, a helyi vezérlőn lévő IN1 
helyett. A távoli IN1 bemenet ugyanazzal a funkcióval rendelkezik 
majd, mint a helyi IN1 bemenet, és a vezérlő IN1 bemenete le lesz 
tiltva. 

2. Ignoe IN2 on controller, enable IN2 on XM-2 / IN2 tiltása a 
vezérlőn, IN2 engedélyezése az XM-2-n – a vezérlő a távoli (az 
XM-2) IN2 bemenetet fogja használni, a helyi vezérlőn lévő IN2 
helyett. A távoli IN2 bemenet ugyanazzal a funkcióval rendelkezik 
majd, mint a helyi IN2 bemenet, és a vezérlő IN2 bemenete le lesz 
tiltva. 

 
• PSAM-1 modul- A vezérlőhöz a Clock & Data vonalon keresztül egy 

PSAM-1tápegység riasztás modul (cím ID=4) köthető. A PSAM –1 a 
Roger beléptető rendszer egy opcionális tápegysége, amely a következő 
adatokat mutatja meg: 
• Aktuális DC kimenet szint 
• Alacsony akkumulátor töltöttség riasztása 
• Akkumulátor hiba riasztás 



 

Megjegyzés: 

A PSAM-1 automatikus vagy hálózati üzemmódban is dolgozhat, de ha a Clock 
& Data vonalhoz van kötve, akkor ID=4 címmel hálózati üzemmódba kell 
konfigurálni. 

A PSAM-1 modul opció aktiválása: Enable PSAM-1 power supply alarm 
module / PSAM-1 tápellátás riasztás modul engedélyezése. 

 

Advanced / Haladó 

Anti-passback (APB) 

Ha a vezérlő távoli beléptető terminállal együtt működik, akkor a telepítő 
aktiválhatja az anti-passback opciót. Ha ez az opció aktív, a vezérlőt 
alapérzelmezés szerint az ajtó „kilépés” oldalára kell helyezni, és a beléptető 
terminált az ajtó „belépés” oldalára, de ez a Terminal ID1, ID0 / ID0, ID1 
terminál füleken megváltoztatható.  Ha APB aktív, akkor a felhasználóknak az 
azonosítójukat a „belépés” és „kilépés” oldalon felváltva kell használni. 

Az Anti-passback két típusa: 

• Szigorú anti-passback (APB Hard) 
• Rugalmas anti-pass-back (APB Soft) 

 

A szigorú és rugalmas APB üzemmódok között az előre beállított időzítőkkel 
lehet váltani. Ha az Always / Mindig időzítő lesz kiválasztva, akkor csak a 
szigorú APB lesz aktív, ha a Never / Soha időzítő, akkor pedig a rugalmas APB.  
Egyéni ütemező esetén meghatározott időperiódusokban a szigorú APB lesz 
aktív, az időperióduson kívül pedig az APB rugalmas üzemmódra vált. 

Szigorú APB esetén egy belépési vagy kilépési ponton nem lehet ugyanazt az 
azonosítót két egymást követő alkalommal használni, mert ekkor [Anti-passback 
violation] / [Anti-passback sértés] esemény történik. Rugalmas anti-passback 
esetén, egy belépési vagy kilépési ponton ugyanazt az azonosítót lehet használni,  
de ez is [Anti-passback sértés] eseményt generál. Az anti-passback törölhető 
(inic ializálható) a törlés ütemezőnek megfelelően, vagy manuálisan 
(meghatározott bemeneti vonal, billentyű vagy billentyűzet parancs 
használatával). Az APB törlés után minden azonosító használható a belépési és  
kilépés i oldalon egyaránt, de az első Kártya/PIN azonosítást követően a 
felhasználó köteles felváltva használni a belépés i és kilépési pontokat. Az AP B 



törlés funkcióra konfigurált bemenet aktiválásával manuálisan indítható az AP B 
törlése. 

 

Megjegyzés: 

Hely: A terminál Belépés/Kilépés állapota ebben az esetben az anti-passback 
funkcióra utal, és nem kötődik a T&A üzemmódhoz. 

 

List of LOCAL SWITCHER users / Helyi kapcsoló felhasználók listája 

Minden vezérlőn meghatározható a Helyi kapcsoló felhasználók listája 
(azonosító szám 999-től 3999-ig). Ezek a felhasználók a vezérlőt  
Élesített/Hatástalanított üzemmódba kapcsolhatják. Teljes kapcsoló vagy 
Korlátozott kapcsoló felhasználók nem lehetnek helyi kapcsoló felhasználók,  
mivel ez a funkció az egész hálózatra vonatkozik. 

Local Switchers / Helyi kapcsolók meghatározása: 

• Kattintson az Add/Remove Local Switcher  azaz Helyi kapcsoló 
Hozzáadása/Eltávolítása menüpontra 

• A ’>’  és ’>>’ gombok segítségével adja hozzá a listához 
• Kattintson az OK gombra 

 

Conditional Access / Feltételes Belépés opció 

A Feltételes Belépés opció aktiválása esetén, normál állapotban arra nem 
jogosult felhasználóknak is lehet belépési engedélye, ha valaki már a szobában 
tartózkodik (ez azt jelenti, hogy legalább egy felhasználó státusza: Logged on 
Entry / Belépve). A felhasználó jelenléte a szobában biztosítja a belépésre az 
engedélyt. Nem számít, hogy ki van a szobában, hogy az egy arra jogosult 
személy, vagy egy olyan felhasználó, aki a feltételes belépésnek köszönhetően 
tudott belépni. Az opcióhoz válassza a Mindig, vagy az előre beállított időzítőt.  
Egyes belépési pontnál a Feltételes Belépés beállításakor az egyik vezérlő 
bementi vonalát No. 60: Reset APB register /APB regiszter törlésre kell 
konfigurálni. 

Valós idejű Óra teszt 
A vezérlő táp alá helyezésekor a belső óra még nincsen beállítva.  
Alapértelmezettként az Enable RTC test after power up / RTC teszt 
induláskor opció engedélyezett, és a vezérlő a belső órájának beállításáig nem 
működik. Az óra automatikusan frissíthető, ha a CPR vezérlő központ a 
hálózathoz van kötve, vagy ha a PR Master felügyeleti üzemmódban fut. Ezt 



parancs segítségével manuális úton is végre lehet hajtani. Ha az RTC teszt 
induláskor nincsen engedélyezve, és a vezérlő belső órája még nincsen beállítva,  
akkor az eszköz 2004 január 1-es dátummal indul. Ebben az esetben az 
események regisztrálásra kerülnek az eseménynaplóba, de az események dátuma 
nem lesz megfelelő. Javasolt az óra azonnali frissítése. 

Automatic arming (Auto-arming) / Automatikus élesítés 

Az automatikus élesítés opció a meghatározott időzítőnek megfelelően 
automatikusan ÉLESÍTETT üzemmódba kapcsolja a vezérlőt. Lehetőség van az 
úgynevezett Halasztott automatikus riasztás késleltetésre, arra az esetre, ha a 
rendszer még nem kész a riasztásra (pl. : a szoba nem üres vagy az ajtó nincs 
becsukva), ezt a kimeneti vonal megfelelő állapota jelzi. A halasztott késleltetés  
egy bemeneten, vagy egy billentyűzet parancson keresztül is aktiválható. Az 
automatikus riasztás előtt 5 perccel a vezérlő hang jelet generál, amely az 
élesített üzemmódba kapcsolásról értesíti a felhasználókat. Ez a Disable buzzer 
warning before auto-arming / Zümmer figyelmeztetés kikapcsolása 
automatikus riasztás előtt opció tiltásával kikapcsolható. 

 



 
 
Timers / Időzítők 

Az Időzítők opció lehetővé teszi a jelzés aktiválás időperiódusának 
meghatározását. Az időperiódust 1 másodperctől 120 percig lehet beállítani. A 
jelzés időszakosan kikapcsolható a Flag OFF / Jelzés kikapcsolása opció 
kiválasztásával. A Latch mode / Tárolt üzemmód kiválasztásakor a jelzés nem a 
meghatározott időtartamra, hanem a következő kapcsolásig kapcsol be. 

 

 

[F1] – [F4] Key / [F1] – [F4] gomb 

A RACS négy (F1-F4) gombot használ. A meghatározott időzítőtől függően 
aktivált funkciók mindegyikhez külön hozzárendelhetőek. Ezen kívül kiegészítő 
feltételek is vezérelhetik a gombok működését. A gombok letiltásához válassza 
a No.0: No function / Nem funkcionál  opciót a menüből. 



 

 

Az  [F1] – [F4] gombok funkciói a Bemeneti fülön található funkciókkal szinte 
teljesen azonosak. A Bemenet IN1, IN2, IN3, IN4 fejezetnél bővebben lehet 
ezekről olvasni. 

Az egyedi funkciók leírásai: 

• No. 2: Force Door Lock On / Erőszakos ajtózár be 
• No. 4: Key pressed / Gomb megnyomása (csak esemény) 
• No. 58: Set postponed Auto-arming Delay On / Elhalasztott 

automatikus riasztás késleltetés be 
• No. 59: Set postponed Auto-arming Delay Off / Elhalasztott 

automatikus riasztás késleltetés ki 
• No. 77: Set Intruder + Tamper flags Off / Betörés+Szabotázsjelzés ki 

 



Keypad commands / Billentyűzet parancsok 

Közvetlenül a vezérlő billentyűzetéről is lehet parancsot kiadni. Kiválasztható,  
hogy mely terminálok parancsait fogadja el a rendszer. A billentyűzet parancsok 
az előre meghatározott felhasználók számára érhetőek el. Mind a 33 lehetséges  
funkció a kiválasztott időzítőtől függően aktiválható / deaktiválható, de néhány 
ezek közül megfelelő jogosultságot követel meg.  A parancsoknak kiegészítő 
feltételek is megadhatóak. 

A billentyűzet parancsok meghatározása: 

• Kattintson a User allowed for keypad commands / Felhasználók 
hozzáférése a billentyűzet parancsokhoz 

• A listához a ’>’ és ’>>’ gombok segítségével adhat további felhasználókat 
• Az elfogadáshoz kattintson az OK gombra 
• Válassza ki a billentyűzet funkciót a listából 
• Kattintson a Properties / Tulajdonságok gombra 
• Engedélyezze vagy tiltsa a  User identifier required / Felhasználói 

azonosító kötelező opciót 
• Válasszon Schedule / Időzítőt a listából 
• Ha szükséges, akkor válasszon Condition / Feltételt 
• Kattintson az OK gombra 



 

A billentyűzet parancsok funkciói a Bemeneti fülön található funkciókkal szinte 
teljesen azonosak. A Bemenet IN1, IN2, IN3, IN4 fejezetnél bővebben lehet 
ezekről olvasni. 

A lehetséges billentyűzet parancsok a következők: 

• No. 00: Set controller ID / Vezérlő azonosítójának beállítása – [*] [00] [#] 
[ID] 

• No. 01: Set date / Dátum beállítása – [*] [01] [DDMMYW] [#] – itt a DD 
a nap, MM  a hónap, Y  az év utolsó számjegye, W a hét napja, 0-  
vasárnap, 1 – hétfő, stb... 

• No. 02: Set c lock / Óra beállítása – [*] [02] [#] [HHMM] [#] – itt a HH 
az óra, MM a perc 

• No. 03: Set Card and PIN mode on terminal ID1 / Kártya és PIN 
üzemmód beállítása az ID1 terminálon 

• No. 04: Clear Card and PIN mode on terminal ID1 / Kártya és PIN 
üzemmód törlése az ID1 terminálon 

• No. 05: Clear Card and PIN mode on terminal ID0 / Kártya és PIN 
üzemmód beállítása az ID0 terminálon 



• No. 06: Clear Card and PIN mode on terminal ID0 / Kártya és PIN 
üzemmód törlése az ID0 terminálon 

• No. 07: Set Normal Door Mode / Normál ajtó üzemmód beállítása 
• No. 08: Set Locked Door Mode / Zárt ajtó üzemmód beállítása 
• No. 09: Set Unlocked Door Mode / Nyitott ajtó üzemmód beállítása 
• No. 10: Set Cond.Unlocked Door Mode / Feltételesen nyitott ajtó 

üzemmód beállítása 
• No. 11: Set Disarmed Mode / Hatástalanított üzemmód beállítása 
• No. 12: Set Armed Mode / Élesített üzemmód beállítása 
• No. 13: Toggle Armed / Disarmed Mode - Élesített/Hatástalanított 

üzemmód kapcsoló – átkapcsolás a üzemmódok között 
• No. 14: Restart controller / A vezérlő újraindítása 
• No. 15: Reset APB Register / Az APB regiszter újraindítása – az APB 

regiszter törlése 
• No. 16: Set T&A Mode Code / T&A üzemmód kód beállítása [...] – 

állandóra változtatás – [*] [16] [#] [NNN] [#] – itt az NNN a T&A kód, 
pl.: 017 – Hivatalos kilépés ( lásd még: T&A üzemmódok). Megadásakor 
a vezérlő a  meghatározott T&A üzemmódba kapcsol. Az új T&A 
üzemmód előre nem meghatározott időre, egészen addig lesz aktív, amíg a 
következő parancs újra meg nem változtatja a vezérlő T&A üzemmódját. 

• No. 17: Set T&A Mode Code / T&A üzemmód kód beállítása [...] – 
pillanatnyi változtatás - [*] [17] [#] [NNN] [#] -  itt az NNN a T&A kód.  
Megadásakor a vezérlő a  meghatározott T&A üzemmódba kapcsol. Az új 
T&A üzemmód a legközelebbi felhasználói azonosításig aktív, de 
amennyiben 8 másodpercen belül nem történik azonosítás, a vezérlő 
visszatér az előzőleg beállított T&A üzemmódba. 

• No. 18: Set Postponed Auto-arming Delay ON / Elhalasztott Automatikus  
riasztás késleltetés be (alapértelmezett késleltetés) 

• No. 19: Set Postponed Auto-arming Delay ON / Elhalasztott Automatikus  
riasztás késleltetés be (késleltetés 1-től 255 percig) 

• No. 20: Set Postponed Auto-arming Delay OFF/ Elhalasztott Automatikus  
riasztás késleltetés ki 

• No. 21: Set LIGHT flag ON / Fényjelző bekapcsolása 
• No. 22: Set LIGHT flag FF / Fényjelző kikapcsolása 
• No. 23: Toggle LIGHT flag ON/OFF / Fényjelző ki/bekapcsolása 
• No. 24: Set AUX1 flag ON / AUX1 jelzés bekapcsolása 
• No. 25: Set AUX1 flag OFF / AUX1 jelzés kikapcsolása 
• No. 26: Toggle AUX1 flag ON/OFF / AUX1 jelzés ki/bekapcsolása 
• No. 27: Set AUX2 flag ON / AUX2 jelzés bekapcsolása 
• No. 28: Set AUX2 flag OFF / AUX2 jelzés kikapcsolása 
• No. 29: Toggle AUX2 flag ON/OFF / AUX2 jelzés ki/bekapcsolása 



• No. 30: Set INTUDER flag ON / BETÖRÉS  jelzés bekapcsolása 
• No. 31: Set INTUDER + TAMPER flags OFF / 

BETÖRÉS+SZABOTÁZS jelzés bekapcsolása 
• No. 32: Set Identification mode for terminal ID1 / Azonosítás üzemmód 

beállítása az ID1 terminálra 
• No. 33:  Set Identification mode for terminal ID0 / Azonosítás üzemmód 

beállítása az ID0 terminálra 
 

Send config. settings to controller / Konfig. beállítások küldése a vezérlőnek 

A vezérlői beállítások megváltoztatása után javasolt a konfigurációk elküldése a 
vezérlőnek. A konfigurációs beállítások frissítéséhez tegye meg a következő 
lépéseket: 

• Kattintson a Networks / Hálózatok gombra az operátor eszközöknél vagy 
válassza az Edit -> Networks / Szerkesztés -> Hálózatok menüpontot 

• Kattintson az Update / Frissítésre 
 

Lásd még: 

Hálózati konfiguráció elküldése 

Rendszer parancsok 

 

Diagnostics / Diagnosztikák 

Ez a funkció lehetőséget ad a vezérlők diagnosztikai műveletének 
végrehajtásához. A diagnosztika parancs elküldéséhez kattintson a Diagnostics/ 
Diagnosztikák gombra a Controllers / Vezérlők menüben. A következő 
menüdoboz jelenik meg: 

 

• Compare data / Adatok összehasonlítása – összehasonlítja a vezérlő 
beállításait a program adatbázisában található konfigurációval 

• Communication test / Kommunikációs teszt – teszteli a kommunikációt a 
PR Master és a vezérlő között 

• Test transmission to CPR / Átvitel teszt a CPR-re 
• Test transmission CPR-PR / Átvitel tesz a CPR és PR között 



 

A kommunikác iós teszt eredményei: 

 

Eredmény: nagyon jó, ideális kommunikáció, nincs összeütközés, és nincs hiba 

 

Eredmény: átlagos, elfogadható válasz 60-80% között, azonban van néhány hiba 
és összeütközés 



 

Eredmény: nagyon rossz, rossz kommunikáció, sok összeütközés és hiba fordult 
elő. Ellenőrizze a vezérlő és a kommunikációs busz kapcsolatát. 

• Test transmission to CPR / Átvitel teszt a CPR-re 
• Test transmission CPR-PR / Átvitel teszt a CPR és PR között 

 

 

Az Átvitel teszt a CPR-re  és a Átvitel teszt a CPR és PR között hasonló módon 
működik. 

A CPR-re történő átvitel teszt végrehajtásához először meg kell határozni az 
átviteli sebességet. A Negotiate / Egyezés opció használatával lekérheti a 
megfelelő átviteli sebességet. 

 

 



 
 
Parancsok a vezérlőnek 

Parancsot a vezérlő kiválasztása után küldhet. Miután rákattintott a [Commands] 
/ [Parancsok] gombra, megjelenik egy menü, amely a vezérlő típusának 
függvényében tartalmazza a lehetséges parancsokat: 

 

A fenti képen a PR402 vezérlő számára elérhető parancsokat láthatja: 

Parancsok: 

• Clear alarm on controller / Riasztás törlése a vezérlőn – a vezérlő 
riasztásának lekapcsolása 

• Release door / Ajtó elengedése 
• Restart controller and verify version / A vezérlő újraindítása és a verzió 

ellenőrzése 
• Set controller to [ON] mode / A vezérlő bekapcsolása 
• Set controller to [OFF] mode / A vezérlő kikapcsolása 
• Set doot to [Normal] mode / Az ajtó átkapcsolása [Normál] üzemmódba – 

az ajtó mindig zárva van, és arra jogosult felhasználó belépése után kinyit 
• Set door to [Unlock] / Az ajtó átkapcsolása [Nyitott] üzemmódba –az ajtó 

mindig nyitva van 



• Set door to [Cond.Unlocked] mode - Az ajtó átkapcsolása [Feltételesen 
Nyitott] üzemmódba – feltételesen nyitott, az ajtó nyitva van az első 
engedélyezett belépésig 

• Set door [Locked] / Az ajtó átkapcsolása [Zárt] üzemmódba – az ajtó 
mindig zárva van, nem számítanak a belépési jogok 

• Controller status / Vezérlő állapota – megmutatja a vezérlői 
információkat, a terminálok állapotát, az ajtó és azonosítási üzemmódokat 

• Reset APB register / APB regiszter törlése – az Anti-passback regiszter 
törlése 

• Read APB register / APB regiszter kiolvasása – megmutatja azoknak a 
felhasználóknak a listáját, akik bejelentkeztek a belépés terminálon 

• Check events buffer in controller / A vezérlő eseménynaplójának 
ellenőrzése– megmutatja a tárolt események számát 

• Clear events buffer in controller / A vezérlő eseménynaplójának törlése 
• Show card limits table / Kártya korlát tábla megmutatása – megmutatja a 

korlátozott felhasználók állapotát, új korlátozott azonosítók hozzáadása 
• Set/ Clear controller output / A vezérlő kimenetének beállítása/törlése 
 

 
 
• Read controller clock / A vezérlő órájának beolvasása – megmutatja a 

vezérlők aktuális belső óráját 
• Read DC output voltage / DC kimeneti feszültség beolvasása – 

megmutatja az aktuális kimeneti feszültséget 
• Read PSAM-1 status / PSAM-1 státusz beolvasása 



 

Microproc. Firmware upgrade / Mikroproc. Firmware frissítés 

Az eszköz vezérlő szoftverének frissítése (firmware letöltés) egy olyan művelet,  
amely letölti a vezérlő program új változatát a mikroprocesszor memóriájába.  
Ezt akkor kell végrehajtani, ha az eszköz gyártója piacra bocsát egy új, jobb és 
fejlettebb firmware verziót. A PRxx2 vagy CPR32-SE programozásakor az új 
firmware átvitele egy standard kommunikációs vonalon keresztül történik (ez az 
RS485 A&B vonala). A firmware közvetlenül letölthető a beléptető rendszer  
eszközére, annak telepítési helyétől való elmozdítása nélkül. Ugyanakkor az 
eszközt közvetlenül is csatlakoztathatjuk UT-2 illesztőn keresztül egy másik 
számítógéphez is, de a f irmware letöltéséhez minden esetben szükséges van a 
RogerISP programra. 

Downloading firmware / Firmware letöltése 

A következőkben láthatja egy s ikeres letöltési folyamat lépéseit, alapul véve,  
hogy a vezérlő egy működő beléptető rendszer része, és az új letölteni kívánt 
szoftver ugyanazon a számítógépen van, mint ami a beléptető rendszert kezeli. 

• Indítsa el a RogerISP programot, majd válassza ki, azt a kommunikációs  
portot, amihez az UT-2 illesztő csatlakozik. 

 

• Kattintson a FULL CHIP ERASE / Teljes Chip Törlése gombra, és a 
következő ablak jelenik meg: 



 

• Helyezze a „jumper”-t Firmware Download Mode / Firmware letöltés 
tüskékre 

• Nyomja meg a uP Reset / uP Újraindítás gombot 
• Kattintson az OK gombra, a chip törlése után a következő ablak jelenik 

meg: 

 

• Távolítsa el a „jumpert” és figyelje meg a vezérlő működését. Ha az 
eszköz működésképtelen, akkor az azt jelenti, hogy a művelet sikeres volt 
és a folytathatja a letöltési műveletet. Ha az eszköz továbbra is működik 
és válaszol, úgy, mint a törlés előtt, akkor meg kell ismételni a törlés i 
folyamatot. 

• Kattintson a Full programing cycle / Teljes programozási folyamat 
gombra és a következő üzenet jelenik meg: 

 

• Helyezze a „jumper”-t FirmwareDownload Mode / Firmware letöltés 
tüskékre 

• Nyomja meg a uP Reset / uP Újraindítás gombot, majd kattintson az OK 
gombra. 

• A program kérni fogja az új f irmware HEX típusú fájljának kiválasztását, 
ennek kiválasztása után kattintson az Open /  Megnyitás gombra. 



 
 
• A programozási folyamat elkezdődik. A Roger ISP ablak tetején láthatja 

a küldési folyamatot. 
• Az átvitel befejeztével a következő üzenet jelenik meg: 

 

• Távolítsa el a „jumpert”, és kattintson az OK gombra, ha a vezérlő nem 
működik megfelelően, az azt jelenti, hogy a programozás i folyamat nem 
volt sikeres, és a törléstől kezdve meg kell ismételnie a folyamatot. Ha az 
eszköz megfelelően működik, akkor befejezte az írási műveletet, és  
kiléphet RogerISP programból. 

• Az új firmware letöltése után az eszközt konfigurálja újra a PR Master  
szoftverből. 
 

Megjegyzés: 
1. Egyidejűleg több vezérlőre is letöltheti a firmwaret. Azonban minden 

eszköznél érdemes egyenként ellenőr izni a különböző folyamatokat. 
2. Ha az eszközre való letöltés távolról nem sikerült, például azért nem, mert 

a kommunikác iós buszon zavar volt, akkor csatlakoztassa az eszközt 
közvetlenül a programozó számítógéphez. 

 
 
 
 



Monitoring / Felügyelet 

A Felügyeleti üzemmód a PR Master olyan üzemmódja, amelyben az 
eseménymemóriából az események automatikusan letöltődnek, és a Felügyeleti 
ablakban megjelennek.  Ez azt jelenti, hogy az összes esemény (belépés 
engedélyezve, r iasztás, megszakadt kommunikáció, stb.), amely a vezérlőn 
előfordul, valós időben megjelenik a PR Master ablakban. A program kezelője 
képes az egész RACS rendszer állapotát megfigyelni, valamint képes az 
eszközöket felügyelni. Amikor a PR Master felügyeleti üzemmódba lép, az 
összes esemény azonnal hozzáfűződik az adatbázishoz. Minden eseménytípust 
más-más szín és ikon különböztet meg. A riasztási események külön a Riasztás i 
ablakban is megjelennek. 
 
Alapbeállításként a felügyeletei üzemmód elindítása előtt minden esemény 
letöltődik a rendszer eseménymemóriájából, és hozzáfűződik az adatbázishoz. A 
korábban történt események megtekintéséhez, a Felügyeleti ablakban, válassza a 
a PR Master főmenüjében található Tools / Eszközök  menün belül az -> 
Options->Misc  / Opciók -> Egyéb menüpontot, és jelölje be a Events 
downloaded from networks only upon operator’s request / Események letöltése 
a hálózatról kizárólag operátor opciót. 

 

View / Nézet 

Ez a menü lehetővé teszi a Felügyeleti ablak nézetének megváltoztatását, és 
kiegészítő opciók futtatását (F2-F7 gyorsbillentyűk). A Felügyeleti ablak két 



részből áll: „Események” és „Riasztás”. Itt választhatja ki az oszlopokat,  
amelyek majd megjelennek az ablakban. 

 

Monitoring filter / Felügyeleti szűrő 

A Felügyeleti szűrő segítségével kiválaszthatja azokat az eseményeket, amelyek 
később a Felügyeleti ablakban megjelennek. Az AND/OR ÉS/VAGY szűrő mód 
kiválasztásával feltételeket adhat meg. Az AND módot akkor használja, ha az 
összes kiválasztott feltételnek teljesülnie kell, az OR módot akkor, ha a 
kiválasztott feltételek közül legalább egynek kell teljesülnie. 



 

Az opciók leírása: 

• Read / Olvasás – a szűrési feltétel beolvasása egy külső (*. rmf) fájlból 

• Save / Mentés – a szűrési feltétel mentése egy külső (*.rmf) fájlba 

• Clear / Törlés – Az összes beállítás törlése és a szűrők tiltása 

 

A Felügyeleti ablak szűrőjének meghatározása: 

• Engedélyezze a Monitoring filter active / Felügyeleti szűrő aktív opciót 

• válassza ki a Filter mode / Szűrés üzemmódját (feltétel megadása) a rádió 
gombra kattintással 

• Kattintson az egyik Active subfilter / Aktív alszűrőre: Események,  
Csoportok, Felhasználók, Vezérlők stb. 

• A „>” és a „>>” gombok segítségével adja hozzá a kívánt elemeket a 
listához 



• Kattintson az OK gombra 

• Az alszűrő melletti jelölő dobozt jelölje be az aktiváláshoz. 

• Az előző négy lépést követve szüksége esetén adjon hozzá tovább i 
alszűrőket. 

Példa: 

• Válassza ki az AND / OR ÉS/VAGY szűrő módot 

• Határozza meg az Active subfilters / Aktív alszűrőket 

• Kattintson az Events / Eseményekre és válassza ki az: Forced entry / 
Erőszakos belépés, Prealarm / Előr iasztás, Duress Entrance / 
Kényszerítés és a Door ajar / Ajtó félig nyitva eseményeket 

• Kattintson a Zones / Zónákra és válassza ki a: pl.: Zóna X vagy a Zóna 
Y-t 

• Hagyja a dátum jelölő négyzetet üresen 

Leírás: 

1. Ha az ÉS módot választotta 

A Felügyeleti ablak csak azt az eseményt mutatja meg, amely teljesíti az ÉS 
mód feltételeit. Ez azt jelenti, hogy csak az az esemény jelenik meg, amelyik az 
összes aktív alszűrő feltételének megfelel. Ha a szűrő a példában látható módon 
van beállítva, akkor a Felügyeleti ablak megjeleníthet pl.: Előriasztást az X 
Zónában vagy Ajtó félig nyitva állapotot az Y Zónában. 

2. Ha a VAGY módot választotta 

A Felügyeleti ablak csak azt az eseményt mutatja meg, amely teljesíti a VAG Y 
mód feltételeit.  Ez azt jelenti, hogy csak az az esemény jelenik meg, amelyik az 
összes aktív alszűrő feltételei közül legalább egynek megfelel. Ha a szűrő a 
példában látható módon van beállítva, akkor a Felügyeleti ablak megjeleníti az 
összes Előriasztást, Kényszerített belépést, Erőszakos belépést, Ajtó félig nyitva 
eseményt és az összes eseményt az X Zónában és az Y Zónában. 

Events alert / Esemény riasztás 

Az esemény r iasztás lehetővé teszi felügyeleti üzenetek meghatározását, 
amelyek bizonyos események előfordulásakor előugró üzeneteket jelenítenek 
meg. Az események meghatározásához szűrőket kell beállítani (ez azonos a 
Felügyeleti szűrő beállításával). 



 

Az esemény riasztó meghatározása: 

• futtassa a Monitoring mode / Felügyeleti üzemmódot 

• válassza ki az Events Alert / Esemény riasztót  (F3)  a Nézet menüből 

• jelölje be az Alert active / Riasztás aktív opciót 

• határozza meg a Filtering criteria / Szűrési feltételeket 

• az Alert Action / Riasztási akc ió mezőben adja meg azt a rövid üzenetet,  
mely figyelmeztetni fogja esemény előfordulásakor. 

Részletesebb üzenet kijelzéshez használja a következőket: 

• %u – felhasználó 

• %g – csoport 

• %e – esemény 

• %c – vezérlő 

• %s – alrendszer 

• %n – új sor 

Megjegyzés: 

Pontos üzenetek létrehozásához kombinálja a felsorolt rövidítéseket. Ezek 
különösen hasznosak több szűrő feltétel beállításakor. 

 

 



User login table / Felhasználói bejelentkezés ablak: 

A felhasználói bejelentkezés ablak megmutatja, hogy a felhasználó melyik 
vezérlőn jelentkezett be legutóbb. Ez a felhasználó aktuális helyzetének 
meghatározásakor nyújt segítséget, így a felügyeleti ablakban nem szükséges a 
hosszú listát végigböngészni. A bejelentkezettek listája meghatározott 
sorrendben is megtekinthető, és a T&A üzemmód szűrőt is használhatja. 

 

Megjegyzés: 

1. Hosszú felhasználói lista esetén a Keresés opció segítségével név alapján 
is lehetőség van a keresésre. 

2. A bejelentkezett felhasználók listájának gyors megnyitásához használja 
Felügyeleti üzemmódban az F4 gyorsbillentyűt. 

Lásd még: 

Felügyeleti szűrő 

Csapda meghatározása 

 

 



Access point monitor / Belépési pont felügyelet 

A Belépés i pont felügyelet lehetővé teszi egy kiválasztott belépési pontnál a 
felhasználók mozgásának megfigyelését. Ennél az opciónál, a kiválasztott 
belépési pontnál történő azonosítás információt jelenít meg a felhasználóról 
(lásd a lenti képernyőképet). A belépési pontot felügyelő személy 
összehasonlíthatja a felhasználót az ablakban megjelenő fényképpel. Ha az 
[Only users login] / [Csak felhasználók belépése] opció aktív, akkor a regisztrált 
felhasználóról csak megmutatja az információt, ha az opció nem aktív, akkor 
egy vezérlőn három egymást követő ismeretlen azonosító általi belépési kísérlet 
után „Előr iasztás” eseményt generál. 

1. Ez a funkció akkor hasznos, ha bizonyos felhasználói csoportnak nincs 
belépési joga, és az ajtó nyitva marad egy másik személy azonosítása után. Ez 
azt jelenti, hogy egy arra jogosult személy nyitva hagyja a felhasználónak az 
ajtót, miután összehasonlította őt a hozzá rendelt fotóval. 

2. Kamerákkal bővített beléptető rendszereknél szintén alkalmazható. Távoli 
belépési pontok felügyeletére alkalmas. Ekkor a kamerákkal készített felvételek 
külön kijelzőkön (monitorokon) megjelennek, hogy azokat a felhasználó 
adataival össze lehessen hasonlítani. 



 

 

Controller status / Vezérlő állapot 

A vezérlő állapot opció segítségével megjeleníthető a vezérlő állapota, mint 
például az Ajtó üzemmód, Azonosítás üzemmód, Bemeneti és Kimeneti vonalak 
állapota. Ezen a szinten csak a felügyelet lehetséges, parancs küldése, és a 
megjelenítés változtatása nem engedélyezett. 

Megjegyzés: 

Az adatok hat percenként frissülnek. BD megjelenése azt jelenti, hogy nincs 
adat. 



 

 

View map (Graphical view) / Áttekintő térkép (grafikai nézet) 

A Grafikai nézet lehetővé teszi a kiválasztott, háttérképen lévő vezérlők 
állapotának felügyeletét. Az ikonként megjelenő eszközöket a betöltött kép 
bármely pozíciójába helyezheti (tárgy elrendezés, épület térkép). Ez segít a 
vezérlők azonosításában, például azonnal parancsot küldhet egy meghatározott 
vezérlőnek. 

 

 



 

A grafikai nézet konfigurálása: 

• Jelölje be az Edit mode /  Szerkesztés üzemmód négyzetet 

• Kattintson az Add icon / Ikon hozzáadása gombra 

• A következő ablakban válassza ki azokat a vezérlőket, amelyeket 
felügyelni kíván, a kiválasztáshoz jelölje be a megfelelő négyzeteket 

• Kattintson a Add selected / Kiválasztott hozzáadása gombra 

• Kattintson a Load image / Kép betöltése gombra a háttér beállításához 

A konfiguráció befejezésével vagy a Szerkesztés üzemmód kijelölésének 
megszüntetésével a felügyelet elindul. Némely esetben szükség lehet a vezérlő 
ikonjának testre szabására. Az ikon személyre szabásához lépjen be a 
Szerkesztés üzemmódba. Az ikonok szerkesztéséhez kattintson az Customize 
Icon / Ikon személyre szabása gombra, és a következő ablak jelenik meg: 

 

A felügyeleti üzemmód futtatásához szüntesse meg a Szerkesztés üzemmód 
kijelölését. 



- Az egér bal gombjával kattintson az ikonra a kibővített üzemmód 
használatához. 

- Az egér jobb gombjával kattintson az ikonra és válassza ki a megfelelő 
parancsot, hogy parancsot küldhessen a vezérlőnek. 

Lásd még: 

Vezérlői státusz 

 

Commands / Parancsok 

A parancs végrehajtása felügyeleti üzemmódban: 

• Válassza ki a kategóriát: Controller commands / Vezérlői parancs, Zones 
commands / Zóna parancs vagy System commands / Rendszer parancs 

• Válassza ki a megfelelő vezérlőt vagy zónát a következő ablakban (ha el 
szeretné küldeni a parancsot a rendszernek, akkor kattintson az OK 
gombra a megerősítéshez) 

• Kattintson a parancs nevével feltüntetett gombra 

 



Tools / Eszközök 

Operator rights / Operátor jogok 

A felügyeleti ablakhoz a kiválasztott kezelők részére belépési jogokat lehet 
meghatározni. A konfiguráció a megfelelő négyzetek kijelöléséből áll, amely a 
felügyeleti ablak menüpontjait tartalmazza. A befejezést követően a 
változtatások mentéséhez kattintson az Apply / Alkalmazás gombra. 

Ha csak az ADMIN kezelő van, akkor meg kell adni egy új kezelőt: 

• Zárja be az ablakot 

• Zárja be a felügyeleti ablakot 

• Válassza ki a Tools / Eszközöket a főmenüből, majd a Program operators 
/ Program operátorok menüpontot 

• Kattintson az Add  / Hozzáadás gombra 

 

 

Online reports / Online jelentések 

Online jelentések hozhatóak létre. Ha az opció aktív, akkor a RACS rendszerről 
az összes meghatározott célállomásra az eseményeket azonnal elküldi. Az összes 
meghatározott célállomáson szűrési feltételeket is meg lehet adni. A szűrő 
konfigurálása a Felügyeleti szűrő beállításával azonos. 



A szűrő aktiválásához: 

• Kattintson a Report filter / Jelentés szűrő fülre 

• Jelölje ki az Online Report Filter active / Online jelentés szűrő aktív 
négyzetet 

• Állítsa be a szűrő üzemmódját és feltételeit 

Ez az opció különösen hasznos, ha az operátor az összes eseményt, vagy csak 
bizonyos eseményeket akar kinyomtatni, vagy távoli könyvtárba akar 
eseményeket menteni. Több nyomtató, fájl és port beállítása is lehetséges. 

 

Lásd még: 

Felügyeleti szűrő 

 

Events mail configuration / Esemény e-mail konfiguráció 

Az összes, vagy a kiválasztott eseményeket e-mailben elküldheti. 

Ehhez szükséges: 

• Jelölje be az Output filter active / Kimeneti szűrő aktív opciót 

• Határozza meg az eseményeket az Active subfilters / Aktív alszűrők 
mezőben 



• Kattintson az Account configuration / Postafiók konfiguráció gombra 

• Konfigurálja a postafiókot (az e-mail postafiók konfigurálása az XML 
jelentés és e-mail funkciókban megismertek szerint történik) 

A befejezést követően leellenőr izheti a beállításokat a Send test e-mail now / 
Teszt e-mail küldése most gombra kattintva. 

 

 

Events / Események 

Eseménynapló (vagy eseménytár) megmutatja az adatbázisban tárolt összes, 
vagy szűrt eseményt. Az események közvetlenül exportálhatóak CSV fájlba,  
vagy T&A jelentésbe. 



 

 

Lásd még: 

CSV Jelentés 

T&A Jelentés 

Jelenlét a területen jelentés 

 

Filter configuration / Szűrő konfiguráció 

A szűrő konfigurálásával határozza meg, hogy a RACS adatbázisban tárolt 
események közül mely eseményeket szeretné megtekinteni. Ha a Filter active / 
Szűrő aktív opciót kikapcsolta, és az OK gombra kattintott, akkor az összes 
regisztrált esemény megjelenik az Esemény napló ablakban. Az AND/OR szűrő 
mód kiválasztásával szűrési feltételeket állíthat be.  AND mode / ÉS mód – 
amikor az összes kiválasztott feltételnek eleget kell tenni, az OR mode / VAG Y 
mód – amikor az összes kiválasztott feltétel közül legalább egynek meg kell 
felelni. 



 

Az opció meghatározása: 

• Read / Beolvasás – szűrés beolvasása egy külső (*.rmf) fájlból 

• Save / Mentés – szűrés mentése egy külső (*.rmf) fájlba 

• Clear / Törlés – az összes beállítás törlése és a szűrő kikapcsolása 

 

A felügyeleti ablak szűrőjének beállítása: 

• Jelölje be a Monitoring filter active / Felügyeleti szűrő aktív opciót 

• Válassza ki a Filter mode (type of condition) / Szűrő üzemmódját (a 
feltételek típusát) az OR/AND mode / VAGY/ÉS mód rádiógombjára 
kattintva 

• Kattintson az egyik Active subfilters / Aktív alszűrőre: Events / 
Események, Groups / Csoportok, Users / Felhasználók, Controllers / 
Vezérlők stb. A következő ablak jelenik meg: 



 

 

• További elemeket adhat a listához a „>” és a „>>” gombok használatával 

• Kattintson az OK gombra 

• Jelölje be az alszűrő mellett található négyzetet az aktiváláshoz 

• Szükség esetén adjon hozzá további alszűrőket az előző négy lépésben 
tanultak szerint 

Szükség szerint a Start date / Kezdő dátumot vagy az End date / Befejezési 
dátumot is megadhatja. Így megtekinthetőek azok az események, amelyek a 
megadott kezdő dátum után vagy a megadott Befejezési dátum előtt  
történtek. Ha mindkét dátumot megadja, akkor a két dátum között történt 
eseményeket tekintheti meg. Ha csak dátum szerint szeretne szűrni, akkor az 
alszűrőket nem kell beállítani. 

Példa: 

• Válassza ki az AND / OR, ÉS/VAGY szűrő módot 

• Határozza meg az Active subfilters / Aktív alszűrőket 

• Kattintson az Events / Eseményekre és válassza ki az Erőszakos belépés, 
Előr iasztás, Kényszerítés és Ajtó félig nyitva eseményeket 

• Kattintson a Zones / Zónákra és válassza ki pl.: Zóna X vagy a Zóna Y-t 

• Hagyja a dátum négyzetet üresen 



 

Leírás: 

1. Ha az ÉS módot választotta 

Az eseménynapló megjelenítő csak azt az eseményt mutatja meg, amely teljesíti 
az ÉS mód feltételeit. Ez azt jelenti, hogy csak az az esemény jelenik meg,  
amelyik az összes aktív alszűrő feltételének megfelel. Ha a szűrő a példában 
látható módon van beállítva, akkor az Eseménynapló listája csak a következő 
eseményeket jeleníti meg, pl. : Előriasztást az X Zónában vagy Ajtó félig nyitva 
állapotot az Y Zónában. 

2. Ha a VAGY módot választotta 

Az eseménynapló megjelenítő csak azt az eseményt mutatja meg, amely teljesíti 
a VAGY mód feltételeit.  Ez azt jelenti, hogy csak az az esemény jelenik meg,  
amelyik az összes aktív alszűrő feltételei közül legalább egynek megfelel. Ha a 
szűrő a példában látható módon van beállítva, akkor az Eseménynapló listája 
csak a következő eseményeket jeleníti meg, pl.: összes Előr iasztást, 
Kényszerített belépést, Erőszakos belépést, Ajtó félig nyitva eseményt és az 
összes eseményt az X Zónában és az Y Zónában. 

CSV Report / CSV Jelentés 

A teljes esemény jelentés, vagy a szűrt esemény jelentés *.csv kiterjesztésű 
fájlba exportálható. Az MS Excel szoftverben a CSV jelentéseket megnyithatja. 

Esemény jelentések konfigurálása: 

• A jelölőnégyzetre kattintva válassza ki a jelentések oszlopát 
• Válasszon columns’ separator / oszlop elválasztót 
• Válassza ki a helyét, és adja meg a fájl nevét 
• Kattintson az OK gombra 

 

Megjegyzés: 

1. Alapértelmezés szerint egy oszlop sincsen kijelölve, ezért a jelentés  
elkészítése előtt ne felejtse el a kívánt oszlopokat kijelölni. 
2. A CSV MS Excellel való megnyitása előtt kövesse a következő lépéseket: 

• Kattintson a File->Open / Fájl -> Megnyitás menüpontra 
• Válassza ki a fájl típusát: szöveg fájl (*.prn, *. txt, *.csv) 
• Válassza ki a CSV fájlt és kattintson az OK gombra 

 



 

 

T&A report / T&A jelentés 

Lehetőség van RCP jelentések létrehozására, amelyek segítségével, a PR 
Masterből az adatokat egy külső bérszámfejtő szoftverbe lehet exportálni. A 
jelentés azokat az eseményeket tartalmazza, amelyek hatással vannak a T&A 
regisztrálásra. Az összes olyan Belépés engedélyezve eseményt, amelynek 
nincsen T&A jele figyelmen kívül hagyja, és ezek az események nem kerülnek 
be a listába. A felsorolt eseményeket színek különböztetik meg, ez segít a T&A 
események áttekintésében. 

A T&A események leírása: 

• piros betűtípus – Bejárat 
• Zöld betűtípus – Kijárat 
• Kék betűtípus – Hivatalos kilépés (ODE) 
• Fekete betűtípus, piros háttér – saját T&A üzemmód (50-től 254-ig 

terjedő azonosító) 



 

 

T&A jelentés létrehozása: 

• Kattintson az OK gombra, és a következő ablak jelenik meg: 



 
 

• Válassza ki a célmappát és adja meg a fájl nevét 
• Válassza ki a T&A jelentés típusát 
• Kattintson a Save / Mentés gombra 

 

A RACS rendszerbe a következő típusú jelentés fájlok hozhatóak létre: 

• RCP – Polman ( RcpAccess Pro+, Net+) 
• Gatyfikant – INSERT 
• Agrobex 
• Symfonia RCP 
• SDF Singapore 
• CIS Singapore 
• Sykom 

 

Lásd még: 

T&A üzemmódok 



Attendance in area report / Jelenlét a területen jelentés 

A meghatározott területen töltött munkaórák kiszámításában jelent segítséget. A 
teljes jelenléti idő a Belépés (Belépési pontoknál regisztrált Engedélyezett 
belépések) és Kilépés (Kilépési pontoknál regisztrált Engedélyezett kilépések) 
események alapján számítható ki. 

Jelenléti jelentés létrehozása: 

• Válassza ki a főmenüből a Reports-> Attendance / Jelentések -> Jelenlét  
opciót 

• Adja meg az From/To, Tól/Ig ntervallumot (dátum és óra) 
• Válassza ki a User group / Felhasználói csoportot 
• Válassza ki a T&A területet (Edit -> Attendance / Szerkesztés -> Jelenlét 

menüpontnál meghatározott) 
• Adja meg a maximális elfogadható jelenléti időtartamot (00:00-t ne 

állítson be) 
• Kattintson a Refresh / Frissítés gombra a beállítások elfogadásához 

 

A jelenlét jelentés kinyomtatható a Print / Nyomtatás nyomógombbal, vagy 
(*.rtf) fájlba menthető a – Save / Mentés nyomógombbal. Az „rtf „ jelentés  
típusa is kiválasztható: 

• Normal (summary attendance in area) / Normál (összesített jelenlét a 
területen) – a jelentés a felhasználók összes jelenléti idejét tartalmazza 

• Detail (sumary and detail users attendance in area)/ Részletes 
(összesített és részletes felhasználói jelenlét a területen) – a jelentés a 
felhasználók összes és a részletezett jelenléti idejét tartalmazza 



 
Ha a Time (hh:mm:ss) / Idő (óó:pp:mpmp) mezőben a „?” karaktert látja, akkor 
az azt jelent, hogy a program nem kapta meg a Belépés vagy Kilépés eseményt. 
Ebben az esetben a View selected / Kiválasztott megtekintése gomb segítségével 
módosítsa a hiányzó dátumot és időt. 



 
A hiányos idő periódusokat letilthatja az Ignore incomplete data / Hiányos 
adatok figyelmen kívül hagyása gombra kattintva. Ebben az esetben csak a 
teljes idő periódusokkal dolgozik a rendszer . 

 

Reports / Jelentések 

„Nyomtatható” jelentések hozhatóak létre. A jelentés a rendszer fő elemein 
alapul (Csoportok, Felhasználók, Zónák, Hálózatok, Vezérlők). Ezek nem 
szerkeszthetők és nem menthetők, csak a nyomtatási kép megtekintésére 
szolgálnak. 

 
System with/without CPR / Rendszer CPR- rel vagy anélkül 

Hálózati működés CPR –rel 

Ha a PRxx2 típusú vezérlő más vezérlőkkel és a CPR vezérlő központtal együtt 
működik hálózatos rendszerben, akkor a CPR belső memóriájába az események 
az összes vezérlőről folyamatosan töltődnek át. Ha a CPR-rel a kommunikác ió 
megszakad, akkor a vezérlők automatikusan egyedi üzemmódba kapcsolnak, és 
a belső memóriájukba automatikusan eltárolják az eseményeket. Ha a 
kommunikáció helyreáll, akkor a vezérlők automatikusan visszatérnek hálózati 
üzemmódba. A vezérlők mindkét esetben megtartják a teljes funkcionalitásukat 



(a működőképesség nem szűnik meg, és nem is csökken). Normál működési 
állapotban a CPR összehangolja a vezérlők belső óráit, és tárolja a rendszerben 
előforduló eseményeket.  A CPR-ben és a vezérlők memóriájában tárolt 
események a PC adatbázisába manuálisan is letölthetőek, vagy automatikusan 
letöltődnek, ha a PC-n a felügyeletet elindítja. A régi típusú PRxx1 sorozatú 
vezérlőknél nincs lehetőség az események tárolására. Ennek a típusnak az 
eszközei vezérlő központtal működnek. A PRxx1 vezérlőknél a CPR kezeli a 
belépési jogokat, és a CPR tárolja az eseményeket is. 

A fő előnye CPR-rel ellátott hálózatos rendszereknek, hogy a vezérlőkön 
előforduló események azonnali átkerülnek a CPR távoli biztonsági 
memóriájába, és a CPR folyamatosan összehangolja a vezérlők belső óráját, így 
hosszú idő után is ugyanannyit mutat majd az összes vezérlő belső órája. 

 

Hálózati működés CPR nélkül 

Ha a számítógép a beléptető rendszerrel van összekötve, és a PR Master 
felügyeleti ablaka aktív, akkor az események folyamatosan áttöltődnek a 
vezérlőkről a PC adatbázisába. Ha a PR Master felügyeleti ablaka nem aktív, 
akkor az eseményeket a vezérlő belső memóriájára tárolja, később ezeket az 
eseményeket egy parancs indításával át lehet tölteni a PC-re . A felügyeleti 
ablak elindításakor automatikusan áttöltődnek az események. 

A CPR-rel történő hálózati működés legfőbb előnyei: 

• A CPR folyamatosan összegyűjti az eseményeket, és tárolja azokat a 
biztonságos memóriájában (256 esemény típus) 

• A CPR folyamatosan összehangolja az összes vezérlő belső óráját 
(hosszabb idő elteltével is ugyanaz lesz az időbeállítása a vezérlőknek) 

 

A CPR nélküli hálózati működés hátrányai: 

• Ha UT-4 egységen keresztül kapcsolódik a hálózathoz, akkor a CPR 
késleltetést okoz a kommunikációban 

• Ha több mint 8 belső memóriával rendelkező beléptető vezérlő van a 
hálózatban, akkor a vezérlő központ memóriája sokkal gyorsabban 
megtelik. 

 

Megjegyzés: 

1. Ha a PRxx2 vezérlő érzékeli a CPR vezérlőközpont működését, vagy a 
PR Master felügyeleti üzemmódban fut, akkor automatikusan hálózati 



üzemmódba kapcsol. Ha nincs CPR a hálózatban, vagy a felügyeleti 
üzemmód nem aktív, akkor a vezérlő egyedi üzemmódba kapcsol. 

2. A CPR vezérlőközpont használata opcionális és a rendszer  
követelményeitől függ. 

 


